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About this book

This book describes how to use the IBM ImagePlus VisualInfo Client for Windows to
receive, classify, use, store, and view documents. The Client for Windows is a
Windows-based user interface for the IBM ImagePlus VisualInfo solution. You can use
the Client for Windows to do the following:

� Receive documents from a scanner or external files
� Index documents and place them in folders
� Search for specific documents and folders

 � View documents
� Add comments or highlights to documents
� Export documents as external files
� Route documents and folders through a workflow

Who should use this book
Use this book if you are responsible for working with documents using the Client for
Windows.

Although this book is written for the end user, if you are the system administrator for
the Client for Windows, you can use this book to review the procedures users follow
and to assist them in using the product effectively in your enterprise.

The Client for Windows application runs on the following versions of Windows:

� Windows 3.1 or higher
� Windows NT 4.0 or higher

 � Windows 95

How this book Is organized
This book contains the following chapters:

� Chapter 1, “Introducing the Client for Windows” on page 1, gives an overview of
the Client for Windows. It introduces the basic concepts, describes the capabilities
of the system, and presents a sample implementation.

� Chapter 2, “Getting started” on page 7, describes how to log on and off the Client
for Windows, introduces the Main Window, and describes how to get online help.

� Chapter 3, “Entering documents into the VisualInfo system” on page 21, describes
how to scan and import documents into the Client for Windows, and how to export
documents and folders.

� Chapter 4, “Using tables of contents” on page 29, describes how to work with the
Table of Contents windows that list documents and folders. It describes how to use
Tables of Contents to access documents and folders and how to control the
appearance of Tables of Contents.
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� Chapter 5, “Indexing documents and folders” on page 39, describes how to
categorize documents and folders.

� Chapter 6, “Locating documents and folders” on page 43, describes how to search
the fileroom for documents and folders.

� Chapter 7, “Workbaskets, folders, and workflows” on page 55, describes how to
use workbaskets and folders. It also describes how to manage the items assigned
to workflows.

� Chapter 8, “Viewing and annotating documents” on page 67, describes how to use
the Client for Windows to display documents. It describes how to change the way
documents are displayed and how to add notes, highlights, and other annotations
to documents.

� Chapter 9, “Printing documents” on page 83, describes how to print documents
and associated information. It describes how to set print preferences and printer
options.

How to use this book
This user's guide complements the online help available with the Client for Windows.
The book focuses on presenting a general description of various tasks and procedures.
The online help provides detailed descriptions of the menu bar items, window fields,
and client application tasks and procedures.

Help is available for all program windows and tasks. The type of help that appears in
the window depends on what choice you are selecting or what task you are performing
when you request help. For a detailed description of the online help facility, see
“Getting help” on page 17.

If you are not familiar with the Microsoft Windows operating system, refer to the
Windows online helps and tutorials.

 Style conventions
To help you easily understand the text, this book uses the following conventions:

Convention Stands for

Bold Names of controls and push buttons in a window

Italic � Terms defined for the first time in the book
� Names of books or other publications
� Information that you can specify in an entry field
� Information that the program displays in an entry field
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What's new in Version 2.3
IBM VisualInfo version 2.3 contains many enhancements, including new Windows NT
library and object servers, a choice of System Administration programs, one for
Windows NT and one for OS/2, and a simplified procedure for installing Windows
components.

The main enhancements to the Client for Windows are documented in this user guide.
They include the following:

� An improved document viewer that can display multiple documents at one time and
is integrated with the Main Window. (See Chapter 8, “Viewing and annotating
documents” on page 67.)

� A new menu structure: the Selected menu and the Process menu replace the
Contents menu and the Document menu. (See “Main Window menus” on page 9.)

� Additional markup tools for annotating your documents with items such as circles,
boxes, lines, and arrows, as well as notes and highlights. (See “Annotating
documents” on page 72.)

� Advanced search capabilities, including the capability to search for criteria across
index classes, to set complex conditions for searches, and to save and reuse
pre-defined searches. (See “Advanced searches” on page 44.)

� The ability to print documents directly from a Table of Contents. Documents no
longer need to be opened for you to print them. (See Chapter 9, “Printing
documents” on page 83.)

Where to find more information
The entire VisualInfo library is available in HTML format on the VisualInfo Information
CD-ROM and on the ImagePlus home page on the World Wide Web:
http://www.software.ibm.com/is/image .

The printed publications included with each VisualInfo license are:

� Planning and Installation Guide, GC31-7772-03

� System Administration Guide, SC31-7774-03

� Client for OS/2 User’s Guide, SC31-7775-01

� Client for Windows User’s Guide, SC31-9052-01

� License Information, GC31-7773-03

The remaining books in the library are available in HTML format only. Use your
VisualInfo Information CD-ROM and your favorite Web browser to access these books.

� Application Programming Guide for OS/2

� Application Programming Guide for Windows

� Application Programming Guide for AIX
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� Application Programming Guide for MVS

� Application Programming Reference, Volume 1

� Application Programming Reference, Volume 2

� Application Programming Reference, Volume 3

� Messages and Codes

� Migrating Databases to AIX and Windows NT
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Chapter 1. Introducing the Client for Windows

The IBM ImagePlus VisualInfo solution is a complete document management system
designed to simplify your paper-intensive processes and increase productivity. The
VisualInfo Client for Windows provides an interface that enables you to bring
documents into the system, view and work with the documents, and store and retrieve
them.

With the Client for Windows, the basic flow of documents and information is as follows:
to store a document into the system, you import it from a directory or capture it by
scanning its pages. You then index the document with information that will help you
identify it and retrieve it later. From that point, you can electronically route the
document to other users who might do the following:

� Organize documents into electronic folders
� Retrieve groups of related documents and folders
� Start a document or folder on a workflow
� Route a document to other users for additional processing
� Add comments or highlights to a document

There are many ways to customize the VisualInfo system to fit the business needs of
your enterprise. Your exact process depends on how your enterprise has chosen to
implement and configure the system.

When you read this book, keep in mind that your system configuration and user ID
privileges determine what options are available to you and what tasks you can perform.
You might not be authorized to perform some of the tasks described in this book. Your
system administrator can tell you what options are available.

Because the Client for Windows is the main client application you will be using to
access documents and folders in the VisualInfo system, this book frequently refers to it
as the client application. Strictly speaking, “client application” can also refer to the
VisualInfo Client for OS/2, or to any custom-built client application you might use.
However, for most purposes in this book, “client application” and “Client for Windows”
are the same.

Client for Windows concepts
The Client for Windows makes use of the following concepts. For an example of how
the concepts might apply to an actual working system, see “Example of a VisualInfo
implementation” on page 5.

 � Documents
 � Folders
� Tables of Contents

 � Workbaskets
 � Workflows
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Documents are items that can be stored, retrieved, and exchanged as a single unit
among systems and users. A single document can contain many different types of base
parts, including text, images, and objects such as spreadsheet files.

Folders are a way to group related documents and other folders together. Grouping
items in folders makes them easier to retrieve. In addition, the Client for Windows uses
folders to display search results after you search the fileroom. Your system
administrator can define other ways to use folders in your system.

Tables of Contents (TOCs) enable you to access documents and folders for processing.
They are windows that list the contents of a workbasket or folder, or the results of a
search.

A workbasket is a temporary holding place for documents and folders that are either in
process or waiting to be processed. Items in the workbasket are ordered much like
items in a queue. A workbasket definition includes the rules that govern the
presentation, status, and security of its contents. Your system administrator can define
workbaskets to organize your work. A user-selected workbasket enables you to select
documents and folders from a Table of Contents. A system-assigned workbasket does
not have a Table of Contents. It displays items for processing one after the other,
based on their assigned priority.

A workflow is a pre-defined sequence of workbaskets through which a document or
folder travels while it is being processed.

Storing documents in the VisualInfo system
The Client for Windows enables you to bring documents into the VisualInfo system
either by scanning them digitally or importing them as files. VisualInfo stores
documents on an object server that can be accessed with different levels of access
authority from the the various workstations on which the Client for Windows is running.

You can use a scanner to convert your paper documents into document images that
you can store and work with in the Client for Windows. You can use the Client for
Windows to adjust settings for your scanner, scan documents into the system, and save
the scanned documents. For more information, see “Scanning documents” on page 21.

Using the Client for Windows, you can import files from different directories on your
workstation or local area network (LAN). The VisualInfo system supports a variety of
data formats for importing files, and your system administrator can define additional
ones.

You can also export files from VisualInfo to other directories on your workstation or
LAN. You might want to export files to use them with another application or move them
to another location. For more information, see “Importing and exporting documents or
images” on page 25.
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Adding retrieval information
In order to retrieve documents that you store in your VisualInfo system, you index them
by assigning them values for pre-defined key fields. You can index individual
documents, as well as folders that contain multiple documents. To index an item, you
select an index class and then type in appropriate key field values for it.

An index class is a category used to identify a group of documents and folders stored
in the fileroom. Your system administrator creates index classes that reflect the
business needs of your enterprise. Every index class includes a set of key fields, which
are categories of information such as "Name" and "Social Security Number" that help to
uniquely identify an item.

Although the procedure for indexing is fairly simple, the indexing information you assign
to a document or folder is very important. It influences how the item is stored, retrieved,
presented for display, and processed. For more information, see Chapter 5, “Indexing
documents and folders” on page 39.

Searching for specific documents and folders
The Client for Windows provides a search capability to search the fileroom for specific
items. You can retrieve items within a single index class, or in all classes, by specifying
index field values as search criteria. For more information, see Chapter 6, “Locating
documents and folders” on page 43.

Working with documents and folders
The Client for Windows provides many different options for working with documents and
folders, such as the following:

� Checking out and in
� Adding or removing from a folder or workbasket

 � Routing
 � Suspending
 � Changing priority
 � Displaying
 � Annotating
 � Deleting
 � Exporting
 � Printing

Some of these options are not available when the Client for Windows is installed with a
VisualInfo for AS/400 system. In particular, checkin/checkout, suspending, and workflow
operations are not available.

For an introduction to the basics of working with documents and folders in workbaskets
and workflows, see Chapter 7, “Workbaskets, folders, and workflows” on page 55.
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In the Client for Windows, processing documents and folders means specifying how
and where they should be routed for work, and whether they are available to work on.
Processing includes the following activities:

Checking documents and folders out and in:  Checking out a document or folder
ensures that only one user is working with the item at a time. When you
check out an item, other users can view it, but cannot perform any
processing tasks on it. When you check in a document, you free it for other
users to process.

Routing documents and folders to workbaskets:  You can route a document or
folder from one workbasket to another. For example, you might route a
document or folder to the workbasket of a supervisor if you discover a
problem with it. When items are in a workflow, you can route the item to
the next workbasket in the workflow; however, an item does not need to be
in a predefined workflow for you to route it to a workbasket. When you
store documents in the system you can assign them to a default
workbasket. A document or folder can also be automatically started in a
workflow based on its index class definitions.

Moving documents and folders through a workflow:  When you finish processing a
document or folder, you can route the item to the next workbasket in the
workflow, move it to another workflow, mark it as completing the workflow,
or remove it from the workflow.

Suspending documents and folders:  Suspending a document or folder makes it
temporarily unavailable to users working with system-assigned
workbaskets. You can suspend a document or folder until a specified date
and time. In addition, you can suspend a folder until documents of one or
more selected index classes are added to it.

Changing the priority of documents and folders:  Changing the priority of a
document or folder moves it up or down in the processing order in a
system-assigned workbasket.

Working with displayed documents
The Client for Windows provides a variety of functions for working with document
images. Although you cannot change the text or the image of the document itself, you
can use the viewing functions as tools to make your job easier.

If your system administrator has given you the authority to do so, you can annotate
documents in a number of different ways. For example, you might want to add
highlighting or notes to an important section of a document.

Other tools can help you move quickly to the page you want in a document or group of
documents, or zoom in on a portion of a document to read small print. For more
information, see Chapter 8, “Viewing and annotating documents” on page 67.
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 Printing documents
You can print documents when you have them displayed or selected in a TOC window.
For more information, see Chapter 9, “Printing documents” on page 83.

Example of a VisualInfo implementation
To illustrate how the Client for Windows might be tailored to a specific environment,
imagine the claims department for an insurance company where employees gather
information on pending claims and resolve them. Their processes involve large amounts
of paperwork and sharing of documents and information.

To convert the existing processes to a VisualInfo system, the system administrator
would create the following:

 � Index classes

 � Key fields

 � Document folders

 � Workbaskets

 � Workflows

The system administrator might set up user IDs with limited access privileges for
employees who perform only the scanning or the indexing phase of their business.
Employees who review claims might have greater access that permits adding notes and
changing index information, but not deleting documents. Still other users might require
even more extensive privileges to resolve problem claims or correct mistakes.

Index classes and key fields
The index classes are like “file cabinets.” They represent the main categories into which
the company's documents are sorted. The insurance company system might contain the
following index classes:

 � Claim forms
 � Appraisals
 � Policies
 � Accident reports
 � Medical reports
 � Correspondence

Each index class can contain a different set of key fields. For example, the Appraisal
class of documents might include key fields labeled Last Name, Claim Number, and
Appraisal Amount. When an employee of the insurance company needs to retrieve a
particular appraisal, the name, claim number, or appraisal amount can be used to
search for the required document.
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 Folders
As documents enter the system, the client application can automatically sort and store
them into folders. For example, the system administrator can have the client application
automatically store all items indexed with the same claim number in a single folder. In
this way, the client application automatically groups all the documents for a particular
claim together. A folder can also contain the results of a search of the system. When a
system user opens a folder, a Table of Contents window (TOC) lists the documents in
the folder. Claims adjusters or other users can view claims for a particular policy holder
by accessing them from a TOC.

Workbaskets and workflows
Users can process documents according to the workbaskets the documents are
assigned to, and the workflows that connect these workbaskets. Newly scanned or
imported documents might start in a specific workbasket, so that a person assigned to
index them would find the required documents collected in one location.

Once they are indexed, the workflow can automatically route them to workbaskets for
further processing. When a claims processor completes work on a routine form, the
workflow can route it to the workbasket of a senior processor for review. If a claim
presents problems, the claims processor can reassign it to a workbasket for a
supervisor.

Note:  Workflow processing is not available with VisualInfo for AS/400.
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 Chapter 2. Getting started

To start the client application, select Programs  from the Windows Start menu, then
select VisualInfo for Windows , then Client Application .

From Windows 3.1 or Windows for Workgroups 3.11, you can also start the client
application by double-clicking on the Client Application icon in the VisualInfo container
window.

Do not perform any other operation while the program is loading. The program and its
environment require several seconds to load.

The Client for Windows Logon dialog box opens, with the Client for Windows Main
Window behind it. At startup, the Main Window options are disabled until a valid user
logs on.

Figure 1. Logon dialog box

In order for the client to start, the VisualInfo client messenger must be running. The
client messenger starts automatically whenever you start the application. (If you need to
shut down the client messenger, click Stop Client Messenger  on the VisualInfo for
Windows menu.

 Copyright IBM Corp. 1996, 1997  7



Prior to logon, user IDs and passwords must be assigned to each user by the system
administrator. In addition, the library server and object server must be available on the
system. Check with your system administrator if you are not sure about this information.

 Logging on
The Logon dialog box enables you to enter a user ID, Password, and server name
when the Client for Windows starts.

To log on, do the following:

1. Verify that you are logging on to the appropriate library server. Normally, your
system administrator has set a default library server.

2. Enter your user ID. A User ID uniquely identifies each user to the system.

3. Enter your password. A password provides security so that only the authorized
user can log on with that User ID.

4. Press Enter or click on the OK button. The status bar at the lower left corner of the
window indicates that the logon is in progress. When the logon is successful, a
message will display to tell you so.

5. Click on OK to switch to the client application Main Window.

You can change your password by clicking the Change  button located next to the
password entry field. Confirm the new password for verification by the system. After
confirming the password, click on the OK button to save it. To cancel a password
change, click on Cancel  to return to the Logon window.

If the Server field does not display the server you want to log on to, select it from the
drop-down list by clicking on the down arrow and selecting the correct library server.

You can exit without logging on by clicking the Cancel  button and selecting Exit  from
the File menu in the Main Window.

The Main Window
The Main Window is the starting place for all actions you perform with the Client for
Windows. When you open another window, for example a document, workbasket, or
folder, it will open within the main window. The Client for Windows interface is an MDI
(Multiple-Document Interface) that enables a user to open more than one document,
workbasket, or folder at a time.
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Figure 2. The Main Window

The Main Window includes the following:

Standard window controls
Restore, Move, Size, Minimize, Maximize, Close.

Title bar
A horizontal bar at the top of the window that shows the name of the application.
When you open a workbasket, folder, or document, its name displays in the title
bar.

Menu bar
A horizontal bar below the title bar that displays command options.

Tool bar
A horizontal bar below the menu bar that contains short cut buttons for
often-used operations.

Status bar
A horizontal bar at the bottom of the window that displays information about the
Client for Windows.

Main Window menus
The menu bar across the top of the window displays a series of commands. These
commands give you point-and-click access to menus that enable you to work with
documents, folders, and workbaskets in the client application.

The menus change dynamically, depending on whether a folder, workbasket, or
document has focus in the active window. All the possible menu choices are listed
below. To indicate which choices are active for different windows, an “x” appears in the
appropriate column. For choices that are active when no window is open, an “x”
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appears in the “None” column. If a column is blank, the menu does not display on that
window.

All menu options can also be activated by a “hot key” combination of the ALT key and
an underlined letter in the menu command. For example, you can exit the Windows
Client with the key combination of ALT+F, then X. The F in File  and the X in Exit  are
underlined.

 File menu
Displays general actions you can take on files, windows, or the VisualInfo system.

Workbasket Document Folder None

Open x
Browse x
Open Workbasket x x x x
Close x x x
Print x x
Logon
Import x x x x
Scan x x x x
Exit x x x x

 Selected menu
Enables you to work with the contents of the current window.

Workbasket Document Folder None

Index Document x
Document Notes x
Index Folder x
Folder Notes x
Select All x x
Deselect All x x
Add to Folder x x x
Add to New Folder x x x
Add to Workbasket x x x
Export x x x
Delete x x x
Remove from Folder x
Remove from
Workbasket

x x x
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 Process menu
Enables you to perform processing functions on a workbasket or document window.
The Checkout and Workflow functions are not available on VisualInfo for AS/400.

Workbasket Document Folder None

Checkout x x x
Priority x x
Suspend x x
Activate x x
Start Workflow x x x
Change Workflow x x x
Complete Workflow x x x
Remove from
Workflow

x x x

 Edit menu
Enables you to copy a document. Only displays when an open document has focus.

Workbasket Document Folder None

Copy x
Insert New Object x
Object x
Import x

 View menu
Displays viewing options for the document. Only displays when an open document has
focus.

Workbasket Document Folder None

Document Bar x
Comment Bar x
Hide Comments x
Rotate x
Clockwise x
Counter-clockwise x
Previous Page x
Next Page x
First Page x
Last Page x
Go to Page x
Fit x
Zoom In x
Zoom Out x
Zoom To x
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 Image menu
Enables you to change the appearance of a displayed image. Only displays when an
open document has focus.

Workbasket Document Folder None

Enhance x
Invert x

 Comment menu
Enables you to place annotations on a document. Only displays when an open
document has focus.

Workbasket Document Folder None

Pen x
Highlighter x
Box x
Circle x
Line x
Arrow x
Text x
Stamp x
Note x
Eraser x
Delete Selected x
Select Comment x
Bring to Front x
Send to Back x
Property Sheet x

 Workbasket menu
Enables you to move through items in system-assigned workbaskets.

Workbasket Document Folder None

Next x
Save and Next x
Delete and Next x

 Search menu
Enables you to search for documents. Also lists search forms and search form
templates that you have created.

Workbasket Document Folder None

Basic x x x x
Advanced x x x x
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 Options menu
Enables you to customize the client application windows.

Workbasket Document Folder None

Toolbar x x x x
Status Bar x x x x
Thumbnail Bar x x x x
Preferences x x x x
Layout x x

 Window menu
Enables you to open windows and change the way they display on the screen. Also
lists open windows for you to switch to.

Workbasket Document Folder None

Cascade x x x
Tile Horizontally x x x
Tile Vertically x x x
Arrange Icons x x x
Close All x x
Close All Documents x x x
Refresh x x

 Help menu
Displays available help options.

Workbasket Document Folder None

Help Topics x x x x
Using Help x x x x
About... x x x x

Main Window tool bar
The tool bar buttons can be used as a short cut for often-used tasks. To perform the
task, click on the button.

If you hold the cursor over an item on the tool bar a caption pops up, explaining what
the button does. For a slightly longer description of the tool bar button, look at the
status bar (lower left corner of the window) while the mouse is stopped over the button.
The status bar displays a description of the button.

You can toggle the tool bar on and off by selecting Tool Bar  from the Options menu.
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Table 1. Main Window Tool Bar Button Descriptions

Icon Description Menu Command
Keyboard
Shortcut

Logon to VisualInfo File Logon...

Open a workbasket File Open workbasket Ctrl+W

Perform a basic search Search Basic... Ctrl+B

Perform an advanced
search

Search Advanced... Ctrl+A

Open the currently
selected item

File Open Ctrl+O

Edit index of current
folder or document

Selected Index Folder
Index Document

Ctrl+I

View/edit notes for
current folder or
document

Selected Folder Notes...
Document Notes...

Print the selected
document

File Print... Ctrl+P

Gives copyright
information about
VisualInfo Client for
Windows

Help About VisualInfo
Client...

Displays help for
clicked-on buttons,
menus, and windows

Help Index

 Status bar
At the bottom of the window is the status bar. The status bar has two areas for
displaying information:

� The left side of the status bar displays menu item descriptions, tool bar button
descriptions, and current processing status.

� The right side displays information pertaining to a system-assigned workbasket if
one is open. Otherwise, it says “<no active workbasket>.” This applies only to
system-assigned workbaskets. Individual user-selected workbaskets can be open,
and this status bar will still display “<no active workbasket>.”

You can toggle the status bar on and off by selecting Status Bar  from the Options
menu.
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Options and preferences
The Options menu enables you to toggle the tool bar, status bar, and thumbnail bar on
and off. If the Tool Bar,  Status Bar,  or Thumbnail Bar  menu choice has a check
mark, the bar is currently displayed. To remove the bar, select the menu choice. To
restore the bar, select the menu choice again.

If you are working with an open document, you can click on Document Bar  or
Comment Bar  from the View menu to show or hide the document toolbars.

The Layout  choice on the Options menu controls the layout of the key fields that serve
as column headings on a Table of Contents window. For information on using this
choice, see “Configuring the key field layout” on page 32.

The Preferences  choice on the Options menu opens the Operator Preferences window.
This window contains two tabs: General  and Advanced . They enable you to change
the settings for several client application functions.

Figure 3. Operator Preferences, page 1

For information about the preferences on the General  tab, see the following:

� “Creating a default index class” on page 40

� “Displaying a count of items in a workbasket” on page 58
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Figure 4. Operator Preferences, page 2

For information about the preferences on the Advanced  tab, see the following:

� “Controlling the number of items in a table of contents” on page 35

� Chapter 9, “Printing documents” on page 83

 Window display
You can use Window menu commands to change the way your document windows and
Tables of Contents display in your Main Window. Select from the following commands:

Cascade
Arranges the windows in an overlapping fashion.

Tile Horizontally
Arranges the windows in row fashion, one above the other

Tile Vertically
Arranges the windows in column fashion, one next to the other

Arrange Icons
Arranges minimized windows or icons along the bottom of the Main Window

Close All
Closes all open windows

Close All Documents
Closes all open document windows
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Refresh
Updates all Table of Contents windows with changes made to objects in the
VisualInfo system

You can also show or hide your toolbars, status bar, or thumbnail bar. (See “Options
and preferences” on page 15.) When you do not have a document open, the thumbnail
bar displays as a large blank area at the bottom of the Main Window. We recommend
that you hide the thumbnail bar unless you are actually using it. For more information,
see “Thumbnail bar” on page 69.

Year 2000 enablement
The Client for Windows is enabled for the Year 2000. You can enter 4-digit dates in all
date fields. (If you have previously entered 2-digit dates, you must change them
manually; the VisualInfo system will not change them for you.)

To accept and display 4-digit dates, you must also have your Windows operating
system configured properly. In the Control Panel, under Regional (or International)
settings, set the date option to show the 4-digit year.

Although you can still enter 2-digit years, we encourage you not to. The VisualInfo
system interprets a 2-digit year as being in the current century. Therefore,
unpredictable results are possible if your system is storing any dates in a 2-digit year
format.

 Getting help
The online help system provides detailed information on the options and procedures
that you can use as you are using the program. Contextual help provides instant
information about the menu choices you have selected. General help enables you to
access information about the window you are working with, and about tasks you can
perform with the Client for Windows.

Getting contextual help for menu bar and pull-down menu choices
To get contextual help for a menu bar or pull-down menu choice by using the keyboard:

1. Press Alt or F10 to move to the menu bar.

2. Use the arrow keys to move to the menu bar or pull-down menu choice.

 3. Press F1.

4. To exit help, press Esc, double-click on the system-menu symbol in the help
window, or select Exit  from the File menu to return to the window from which you
requested help.
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To get contextual help for a menu bar or pull-down menu choice by using the mouse:

1. Press and hold down mouse button 1 on the menu bar choice.

2. While holding down the button, move the mouse until your choice is selected.

 3. Press F1.

4. To exit help, press Esc, double-click on the system-menu symbol in the help
window, or select Exit  from the File menu to return to the window from which you
requested help.

Getting general help
You can request help for most windows. This general help provides an overview of all
of the actions that you can perform from the window. To get general help for a window,
press F1 while the window is the active window. The general help for the window
appears.

Some windows also have a Help  button that you can click on.

To exit help, press Esc, double-click on the system-menu symbol in the help window, or
select Exit  from the File menu to return to the window from which you requested help.

Getting additional help
You can request additional help for the client application by selecting Help  and then
selecting Help Topics , Using Help , or About ... .

 Help Topics
The Help topics window provides an index to all the help topics available with the client
application. To access a specific help topic:

1. Select Help  and then select Help Topics .
2. In the subject field, type the name of a subject for which you want help. The

subject list scrolls to that name (or the closest available match).
3. Double-click on any name in the subject list to display a list of help topics for that

subject. If there is only one topic for the subject, the help opens for that topic.
4. Click on any item in the topic list to open the help for that item.

You can also search the help system, either for a particular topic or an individual word.

To exit help, press Esc, double-click on the system-menu symbol in the help window, or
select Exit  from the File menu to return to the window from which you requested help.

 Using Help
You can display information about how to use the help facility itself. To display this
information, select Help  and then select Using help .

 About ...
Select Help  and then select About VisualInfo Client  to display the Product Information
window. This window provides copyright and version information about the Client for
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Windows. If an open document window is active, the menu choice changes to About
Viewer . This provides copyright and version information for the document viewer.

Using hypertext links
Within a help window itself, hypertext links enable you to move to help topics that cover
related subjects. Some links give additional information about the highlighted words or
phrases. To get to this help, click on the highlighted term.

 Logging off
You can log off the Client for Windows in one of these ways:

� Select Exit  from the File menu
� Double-click on the system menu symbol in the upper left corner of the window
� Select Close  from the system menu
� On Windows 95 and Windows NT 4.0, click the X button on the upper right corner

of the window.

All of the open program windows are closed.
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Chapter 3. Entering documents into the VisualInfo system

You can enter documents into the VisualInfo system in two ways using the Client for
Windows: scanning them or importing them.

 Scanning documents
Scanned documents are temporarily written to your workstation's fixed disk prior to
being stored on the object server. Normally, they are written to the FRNROOT\WORK
subdirectory. Be sure you have enough free disk space on the drive where this
directory resides. These temporary files are erased as soon as the scanned documents
are successfully stored on the object server.

We recommend that you scan and store your documents at a resolution of 200 dpi or
lower. This provides better performance and helps prevent an out-of-memory condition
that can result from scanning at higher resolutions.

The first time you use a new scanner, you need to load the scanner driver:

1. From the File  menu on the Main Window menu bar, select Scan . A dialog called
Loading Driver Names opens briefly. Then the Scanner Selection window opens.

2. Select your scanner from the list.

 3. Click OK.
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To scan a document into the VisualInfo system, do the following:

1. From the File  menu on the Main Window menu bar, select Scan . This opens the
Basic Scan window.

Figure 5. Basic Scan window

2. On the Basic Scan window, select the following:

� From the Data Format  drop-down list, select the file format for the scanned
image. The drop-down list contains the formats supported by your VisualInfo
system. You can access them by clicking on the down arrow to the right of the
data format field, and then selecting the desired file format with the mouse or
the directional arrow keys. Click on the down arrow again to confirm your
selection and close the list.

� Select Route to Workbasket  if you want your scanned document to be routed
to a workbasket. The Workbasket  drop-down list contains the names of all the
workbaskets you have access to. You can select a workbasket in the same
way you select a data format.

The default workbasket is the To be indexed  workbasket.

� Select Display while scanning  if you want your document to display on your
workstation while it is being scanned.

� Select Duplex  when you want to scan both sides of two-sided documents. The
Duplex  check box is only available if your scanner supports duplex (two-sided)
scanning.

3. Ensure that your document is loaded in the scanner and the scanner is turned on.

4. Click on Scan . If you selected Display while scanning , a Document window
opens. The Document window does not permit you to work with the documents. It
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only lets you view the document you have just scanned. (It differs from the Viewer
window in this way.)

5. Select Save to save the document you just scanned. A Progress Status dialog box
opens to indicate the progress of the save. When this dialog box closes, the save
operation is complete.

6. Select Continue  to scan additional pages to be stored as part of the same
document. Load the next page to be scanned, then click on Continue .

7. Select Discard  to delete the image that you just scanned.

8. Repeat the preceding steps for all documents that you want to scan.

9. When you are finished scanning, click on Close .

Adjusting the scanner setup
You can also use the Basic Scan window to adjust the setup for your scanner or select
which scanning device to use.

When you click on the Setup  button, the Scanner Settings window opens. You can
adjust such settings as mode, dither, brightness, and contrast. These settings are
specific to the brand of scanner you are using. For further information, refer to your
scanner's user documentation.

When you click on the Device  button, the Scanner Selection window opens. You can
use this window to select from among the scanners that are installed on your system.
Select a scanner from the list and click on OK.

The Scanner Selection window also contains an Add  button and a Setup  button. Under
normal circumstances you do not need to use these. The Add  button enables you to
add a scanner driver to your system. The Setup  button opens a Setup window for the
selected scanner, which enables you to specify paper size and a default SCSI device.

For more information on scanning for your specific VisualInfo implementation, check
with your system administrator.

Considerations for specific scanners

 XIONICS scanners
If you are using a XIONICS scanner on Windows 3.1 or 95, you need a special scanner
driver from IBM. Contact your local IBM support for this driver.

 HP scanners
If you are using an HP scanner on Windows 3.1 or 95, you need a special scanner
driver from HP. Contact your local IBM support for further details on what driver you
need.
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IBM 2456 scanner with IBM Pentium PC 750
If you are using an IBM 2456 scanner connected to an IBM Pentium PC 750, ensure
that the scanner is at E-Prom level 1R0G or higher.

Data formats for scanning
To scan large documents (greater than 50 pages), we recommend using either TIFF6
or MODCA2P data formats.

Do not scan using a 12–bit color data format. Only 24–bit color scanning is currently
supported.

The Client for Windows supports the following scan data formats.

Note:  Windows NT does not support the GIF format.

On Windows 3.1, the 24–bit color mode has not been fully tested.

The IOCA data format (Image Object Content Architecture) is not supported. If you
create or import a document with this data format, you will not be able to display the
item with the Client for Windows.

Format Scan modes supported

DCX Black and white (bi-level)
GIF Black and white (bi-level)

16 grayscale
256 grayscale
24-bit color

JPEG 16 grayscale
256 grayscale
24-bit color

MODCA2P Black and white (bi-level)
16 grayscale
256 grayscale
24-bit color

PCX Black and white (bi-level)
16 grayscale
256 grayscale
24-bit color (not recommended)

TIFF6 Black and white (bi-level)

Using IBM 2456 and Ricoh 410 Scanners under Windows
If you use either the IBM 2456 scanner or the Ricoh 410 scanner under Windows, and
you encounter problems, ensure that you contact your IBM Representative to get
information on:

 � Scanner requirements
� SCSI card requirements
� Scanner ROM versions supported
� Scanner termination and impedance requirements
� WINASPI driver information
� Adaptec 1542C and IBM2456 information.
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Importing and exporting documents or images
The Client for Windows enables you to import and export files with a wide variety of file
types into and out of your VisualInfo system. You can work with files in many different
document file formats, including files for applications such as word processors and
spreadsheets.

 Importing
You can use the Client for Windows to import files into your VisualInfo system from
different directories on your workstation or local area network (LAN). The system
supports a variety of data formats for files that you import, and your system
administrator can define additional ones.

Before you begin importing, you need to know the following information about the files:

� What the names of the files are
� Where the files are located
� What format they are in
� Whether you should place the files in a specific workbasket in addition to storing

them in the library

If you are unsure about any of this information, contact your system administrator
before you begin.

To import a document into the VisualInfo system, do the following:

1. From the File menu on the Main Window menu bar, select Import . This opens the
Import Object window.

Figure 6. Import Object window

2. On the Import Object window, select the following:

� From the Data Format  drop-down list, select the file format for the document
to be imported. The drop-down list contains the formats supported by your
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VisualInfo system. You can access them by clicking on the down arrow to the
right of the data format field, and then selecting the desired file format with the
mouse or the directional arrow keys. Click on the down arrow again to confirm
your selection and close the list.

� Select Route to Workbasket  if you want your imported document to be routed
to a workbasket. The Workbasket  drop-down list contains the names of all the
workbaskets you have access to. You can select a workbasket in the same
way you select a data format.

The default workbasket is the To be indexed  workbasket.

� In the File Name  field, enter the complete path name, including the file name,
of the file to be imported, for example, c:\winword\clipart.bmp.

If you are unsure of the name of the file you want to import, click on the
Browse  button to display the Open dialog box. You can then select the file to
import.

You can also import multiple files by selecting them in one of the following ways:

� Type the path name, then the file names, all separated with a space, in the File
Name field. Separate each name with a space, as in this example:

c:\winword clipart1.bmp clipart2.bmp clipart3.bmp

� Click on the Browse  button to display the Open dialog box. Drag the mouse down
the list if the files are listed sequentially, or hold the control button and select each
file individually.

Note:  When you import a file, its file type must match the data format specified in the
Import Objects window. Otherwise, when you retrieve the document later, you
will not be able to view it properly.

 Exporting
You can also export files stored in your VisualInfo system to other directories on your
workstation or LAN. You might export files that you want to use with another application
or move to another location. Before you begin exporting files, you need to know the
following:

� What location to export the files to
� Whether to include any note log or annotation information that is associated with

the files

It is also important to understand the naming procedure the client application follows
when you export files to ensure that you can identify the files after they are exported.
As it exports the files it assigns names and file extensions based on the content of the
files and the format they are in. The names it assigns are unique.
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To export a document:

1. Highlight the document in a Table of Contents window, or open the document.

2. Select Export  from the Selected menu. The Export window opens.

3. Specify the path of the directory to export the file to by typing the path name in the
Destination directory path entry field.

4. Click on the Export  button to begin exporting the file(s).

To export all the documents in a folder:

1. Open the folder table of contents.

2. Select all items in the folder.

3. Select Export  from the Selected menu. The Export window opens.

4. Specify the path of the directory to export the files to by typing the path name in
the Destination directory path entry field.

5. Click on the Export  button to begin exporting the file(s).
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Chapter 4. Using tables of contents

A Table of Contents (TOC) window is a window showing a list of documents or folders.
A TOC window can represent a workbasket, a folder or a search result. Individual
folders and documents are accessed with the TOC window in ways appropriate to the
individual items.

The client application uses Table of Contents windows to organize and present lists of
folders and documents when it opens a folder or workbasket or presents a list retrieved
from a search. You use the TOCs to select the specific documents and folders that you
want to work with.

Figure 7. Table of Contents window

On the left end of each row in the TOC, a button indicates whether the item is a
document or a folder. To the right of this button, the row displays the indexing data that
has been associated with the item. For items that have not been indexed yet,
descriptive information about the item is shown, including the source of the item, the
user who entered it into the system, and a time stamp indicating when it was entered.

Tabs along the top row of the TOC indicate the index classes associated with the items
in the TOC. When the documents and folders listed in the TOC are all of the same
index class, only one tab appears.

If the TOC contains documents or folders in different index classes, each index class
has its own tab (for example, a TOC could contain documents with an index class of
Service Documents and other documents with an index class of Claim). By clicking on
a tab, the user can change to the page of the TOC that lists documents and folders in
that index class.
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The column headings for each page of the TOC represent the key fields for the index
class (such as Claim Number, Customer Number, or Customer Name). You can change
the layout of these key fields by using the Options menu. See “Configuring the key field
layout” on page 32.

Types of tables of contents
The three types of TOC (Folder, Search Results, and Workbasket) look very similar.
However, there are small but important differences between them.

Folder table of contents
In addition to being a container for VisualInfo objects, a folder is itself a VisualInfo
object. Therefore, you can perform actions on it such as adding it to or removing it from
a folder or workbasket, adding notes to it, suspending it or activating it.

To do these actions, you must be able to select the folder. In addition to selecting any
folder by clicking on it in a TOC, you can select the TOC itself by clicking on the
selection icon near the upper left corner. This means that you have selected the folder
represented by the TOC. When you do this, you can perform actions on the folder like
you would on any other object in the VisualInfo system.

Note:  The folder selection icon does not apply to Index folder  or Edit folder notes .
These commands apply to an open folder that is in the active window but does
not have its selection icon selected.

Figure 8 shows the index class tabs for a typical folder TOC, with the selection icon to
the left.

Figure 8. Folder selection icon (unselected)

When you click on the selection icon, a check mark displays to indicate that the folder
represented by the TOC is selected.

Figure 9. Folder selection icon (selected)
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Search results table of contents
The results of a search are displayed in a TOC window which represents a folder, and
can be selected like any other folder. However, until it is indexed, a search results
folder is only a temporary holding place for fileroom objects. You cannot perform
operations on a search results folder such as adding it to, or deleting it from a
workbasket or folder, unless you first index the search results folder. Then it behaves
like any other folder in the VisualInfo system.

After indexing the search results folder, if you want to perform an operation such as
routing it to a workbasket, you need to click on its selection icon, as you would with any
other folder.

Workbasket table of contents
A workbasket is a container for VisualInfo objects but is not itself an object. Therefore,
you can not perform operations on a workbasket such as indexing or adding it to
workbasket or folder. You can only perform such operations on a workbasket as
opening, closing, adding or removing objects, and changing how object names are
displayed. (See  “Workbaskets” on page 56 .)

Because a workbasket is not considered a VisualInfo object, it is not selectable.
Therefore, the selection icon is disabled for all workbasket TOCs.

Opening a table of contents
You can open a TOC in several different ways.

� From the File menu, select Open Workbasket . This opens the Select Workbasket
window. You can select a workbasket and click on OK. This opens a TOC for the
selected workbasket.

Note:  System-assigned workbaskets do not have a table of contents. When you
open a system-assigned workbasket, you are presented with the
highest-priority item in the workbasket.

� From the Search menu, select Basic . This opens the Basic Search window. You
can search the fileroom for documents that meet certain criteria. When the search
is compete, a Search Results TOC opens. For detailed information, see Chapter 6,
“Locating documents and folders” on page 43.

� From any open TOC, you can open a folder TOC in one of the following ways:

– Double-click on the folder button or the row containing the folder information.
– Click on the row containing the folder information to select it, then from the File

menu, select Open .

 This opens a TOC for the selected folder.
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Opening more than one table of contents
The Client for Windows enables you to work with multiple TOCs. To open additional
TOCs, follow the same steps you followed to open the first one. All TOCs remain open
until you close them.

Using the standard window controls, you can maximize, size, or minimize your TOCs.
Using the Window menu, you can choose to display them cascaded or tiled.

You can also use the Window menu to select which TOC you want to view. The
Window menu lists all open windows. Select a window from this list to display that
window in the Main Window viewing area.

Controlling the appearance of the table of contents
The Client for Windows gives you several ways to control the appearance of the Table
of Contents windows. You can configure each window according to how you use it. You
can control the key field order, sort order of the rows, row height, column order, and
width of individual columns.

Configuring the key field layout
You can configure the key field layout for any index class listed in your TOC. This
means that you can choose which key fields appear as the column headings for the
TOC, and the order they appear in.

1. If your TOC contains more than one index class tab, select the tab for the index
class whose key fields you want to configure.

2. From the Options menu, select Layout . This opens the Configure Key Field Layout
window.

Figure 10. Configure Key Field Layout window
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The list on the left, Available Fields , includes all the key fields available for the
selected index class. The list on the right, Display list , includes the key fields
currently displayed, in the same order as they appear in the TOC.

3. Select a key field name from the Available Fields  list.

4. Select a key field name from the Display  list at the location where you want to
insert the new key field name.

5. Click on Copy Above  or Copy Below . This adds the new key field name to the
Display list above or below the selected name.

6. To change the order of the display list, select an item and click on Move Up  or
Move Down .

7. To remove an item from the display list, select the item and click on Remove .

8. When you have finished making your changes, click OK. This saves your changes
to your workstation's hard drive. Whenever you display this index class in a TOC,
its key fields are laid out in the way you specified.

The key field layout is specific to the Client for Windows on your workstation. The
changes you make are only saved on your workstation.

Controlling the layout

Sorting the table of contents
Click on the column name to select a column. The selected column name changes
color. When a column name is selected, the items listed in the Table of Contents are
automatically sorted in either ascending or descending order by the data listed in the
selected column.

The uppercase letters sort first, followed by the lowercase letters. For example,
uppercase “Z” sorts immediately before lowercase “a.”

Selecting the sort order
To change the sort order, click on the arrow in the upper left corner. This toggles the
arrow between ascending and descending order. To sort the Table of Contents in
ascending order (A-Z or 1-9), the blue arrow must be pointing up. To sort in
descending order (Z-A or 9-1), the blue arrow must be pointing down. Figure 11 on
page 34 shows the column headings for a TOC that is sorted in ascending order by the
first column, Brief Description.
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Figure 11. Sort order, ascending

Reducing and enlarging row size
To enlarge or reduce row size in the TOC, position the mouse cursor anywhere on the
line between the first and second row. (Note how the cursor changes to two parallel
lines with arrows on each side, as in Figure 12.) Hold down the left mouse button and
drag the mouse up or down to increase or decrease the row height for the entire Table
of Contents. Reducing the row height enables you to view more information (additional
rows) in the same window.

Figure 12. Changing row size

Column heading row size
You can change the height of the column headings independently of the row heights.
Position the cursor anywhere between the column headings and the row beneath them.
The cursor changes to two parallel lines with arrows on either side. Hold down the left
mouse button and drag the mouse up or down to increase or decrease the height of the
column headings.

Reducing and enlarging column size
To enlarge or reduce the size of columns in the TOC window, position the mouse
cursor between two column headings. Note how the cursor changes to two parallel
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lines with arrows on each side. Hold down the left mouse button and drag the mouse
left or right to increase or decrease the column width for that column.

Refreshing the table of contents
To refresh a Table of Contents window, select Refresh  from the Window menu on the
Main Window menu bar.

This procedure is useful when you want to know the current contents of a container you
are working with. Many actions can change the contents of a folder or workbasket. For
example, you can scan, import, reindex, move, or delete items. If you reindex, move, or
delete items, the TOC refreshes automatically. If you import or scan, however, the
items do not display until you refresh the TOC.

Controlling the number of items in a table of contents
By default, Table of Contents windows display up to 100 items. If an index class or
search result contains more than 100 items, only the first 100 are listed.

You can control the number of items that display in a Table of Contents as follows:

1. Select Preferences  from the Options menu.

2. Click the Advanced  tab.

3. Enter the desired number in the Maximum TOC Count  field.

 4. Click OK.

The Tables of Contents on your workstation will now include up to the number of items
that you assigned in the Maximum TOC Count  field. The default value for the
maximum count is 100. There is no upper limit, but the higher you set it, the slower
your system's performance can be when you retrieve a Table of Contents.

If you enter 0 as your maximum count, your Tables of Contents list all items.

Selecting items from the table of contents
The Client for Windows provides three types of selection emphasis in TOCs, as shown
in Figure 13.

Figure 13. Types of selection emphasis
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� Highlighting indicates that a row is selected. Highlighted rows are black, with
characters appearing in reverse video. When a row is highlighted, you can perform
actions on it using the Selected menu or Process menu.

� A dotted rectangle indicates cursor emphasis on a particular field in the TOC. This
is the field where the cursor is currently located. You can highlight the row that
contains the cursor emphasis by pressing the space bar on your keyboard.

� Hash marks can display on the folder or document button at the left end of a row.
These indicate that the item is open elsewhere on the desktop, even if it is not
currently selected.

You can select items in the following ways:

Selecting a folder or document
Click anywhere on the row that represents the folder or document in the TOC.
The row is highlighted in black, with characters in reverse video, to indicate that it
is selected.

Selecting the currently open folder
To select the currently open folder, click on the selection icon to the left of the
index class tabs. When selected, the icon displays a check mark. (For more
information on the selection icon, see “Types of tables of contents” on page 30.)

Note:  Selecting a workbasket in this manner is not supported.

Selecting multiple items
You can select multiple items in two ways: from the Selected menu or with the
keyboard and mouse.

� To select all items in a TOC, choose Select All  from the Selected menu.

� To select a group of continuous items, select either the top or bottom item
with the mouse, press and hold the Shift key, and select the opposite end
item with the mouse.

� To toggle the selection of a single item in the list, press and hold the Ctrl key
and select the item with the mouse. This selects an item or deselects a
previously selected item without affecting any other items on the list.

Deselecting Items

� To deselect all items in a TOC, choose Deselect All  from the Selected
menu.

� To deselect a single item in a TOC, press and hold the Ctrl key and click on
the item with the mouse.

Checking documents and folders out and in
Checking out a document or folder ensures that only one user is working with the item
at one time. When you check out a document or folder, the folder or document button
displays a checkmark, as in Figure 14 on page 37:
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Figure 14. Checked-out folder and document

When a document or folder is checked out, other users can view it in Browse mode by
selecting Browse  from the File menu. However, they can not work with it until it is
checked back in.

Any time you open a folder or document from the File menu, it is automatically checked
out to you until you close it again.

You can also check out a document or folder by selecting the item and clicking Check
Out  from the Process menu.

When you finish processing a document or folder, and you want to make it available to
other users, you can check it in: select the item and click Check In  from the Process
menu.

Opening documents and folders
To open a document or folder, double-click on the item in a Table of Contents, or select
the item in a Table of Contents and choose Open  from the File menu. You can also
open an item by selecting it in the TOC and clicking the Open  button on the tool bar.

When you open a folder, the folder Table of Contents displays. You can use the folder
TOC to further select documents or folders that you want to work with.

When you open a document, the first page is automatically displayed, even if the
document is large and the client application keeps loading additional pages

You can also open a document in Browse mode. Select the document in a Table of
Contents. Then choose Browse  from the File menu. When an item is open in Browse
mode, you cannot index or delete it. In addition you can view the notes but you cannot
edit or add to them. If you view a folder in Browse mode, you cannot add items to it or
remove items from it.

VisualInfo Client for Windows also allows you to open more than one TOC. To open
additional TOCs, follow the same steps used to open the first one. All TOCs remain
open until you close them.

Use the standard window controls to maximize, size, or minimize your TOCs. Use the
Window menu to display them in tile or cascade style.

Use the Window menu to see which TOCs are open and select which TOC you want to
view. Click on that TOC to view it in the Main window viewing area.

  Chapter 4. Using tables of contents 37



Closing documents and folders
You can close an item in several ways. If a document or TOC is displayed in the active
window, or if an item is selected in a TOC window, you can do one of the following:

� Select Close  from the File menu.
� Press and hold Ctrl+Shift, then press O.

You can also double-click on a window's system icon to close it, or click the X button in
the upper right corner of the window (Windows 95 and Windows NT 4.0).

Removing and deleting items
The Remove from Folder  and Remove from Workbasket  options on the Selected
menu work differently from the Delete  option on the same menu. “Removed” items are
just removed from the TOC of the current folder or workbasket, not from VisualInfo.
“Deleted” items are removed from the VisualInfo system altogether.

Removing items from folders
1. From a Folder Table of Contents window select the items to be removed by

highlighting one or more rows.

2. From the Selected menu, choose Remove from Folder . This opens a dialog box,
asking you to confirm that you want to remove the items.

3. Click on Yes to remove the selected items from the open folder, or No to cancel
the remove process.

Removing items from workbaskets
1. From a Workbasket Table of Contents window select the items to be removed by

highlighting one or more rows.

2. From the Selected menu, choose Remove from Workbasket . This opens a dialog
box, asking you to confirm that you want to remove the items.

3. Click on Yes to remove the selected items from the workbasket, or No to cancel
the remove process.

Deleting items from folders and workbaskets
1. From a Table of Contents window select the items to be deleted by highlighting

one or more rows.

2. From the Selected menu, select Delete . This opens a dialog box, asking you to
confirm that you want to delete the items.

3. Click on Yes to delete the selected items or No to cancel the delete process.
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Chapter 5. Indexing documents and folders

VisualInfo works in a manner similar to the public library system, where books and
other printed material are stored and assigned unique locations. All information stored
in the library can be located by using a catalog that indexes the printed material by
author, subject, publisher, and physical location. VisualInfo provides this cataloging
function through the use of index classes.

 Index classes
An index class is a category used to identify a group of documents and folders. For
example, an insurance implementation might have index classes such as Claims,
Customers, and Policy Types. Your system administrator defines index classes for
your system, according to how items are stored, retrieved, presented for display, and
processed. Each index class includes a set of key fields. When you index a document,
you enter unique information for the document into these key fields.

Figure 15. Index class with key fields

You use index classes and key fields as a basis for the search and retrieval of items in
the VisualInfo system. See Chapter 6, “Locating documents and folders” on page 43
for a full description of searches.

The NOINDEX class
The NOINDEX index class is a system-defined index Class that is always available.
This index class is used when new items such as documents and folders are
introduced into the system and there is no index information available. The NOINDEX
class associates the following information with a new item:

� Its source, such as Import or Scan
� The user ID of the operator who entered it
� A time stamp indicating the exact time the item was introduced

 Copyright IBM Corp. 1996, 1997  39



Creating a default index class
You can specify an index class to be suggested by default when you initially index
documents from the NOINDEX class. To specify a default index class, do the following:

1. From the Options menu, select Preferences . This opens the Operator Preferences
window.

2. Select an index class from the default Index Class drop-down list.
3. Click OK to save this change to your workstation.

Figure 16. Operator Preferences window

For more information on the Operator Preferences window, see “Options and
preferences” on page 15 and “Displaying a count of items in a workbasket” on
page 58.
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Entering or changing index information
You can enter or change index information for existing folders or documents.

1. Open the folder or document to be indexed.

2. From the Selected menu, select Index Folder  or Index Document . This opens the
Edit Index window.

Figure 17. Edit Index window

3. Click on the down arrow to the right of the Index Class  field. This displays a list of
the index classes that you have access to.

4. Click on the desired index class. The key fields for the selected index class will be
displayed.

5. Type the desired index values for the key fields. You only need to type a value for
the required key fields. If a key field requires a value, it is highlighted.

6. Click on the OK button. The new index values for the folder or document will be
associated with the item in the VisualInfo system.

Depending on your system setup, objects might be automatically removed from certain
workbaskets after indexing. However, if the indexed item has been assigned to the
workbasket as part of a workflow, it will remain in the workbasket. This is because
items assigned to workflows must always be in a workbasket.
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Creating a default set of key field values
In the Edit Index window you can save a set of key field values by pressing the Save
button after you enter the values. This saves the current settings as the defaults for the
current index class.

You might want to do this, for example, if you are indexing a series of claims for the
same customer. You could save the information in the key fields for First Name, Last
Name, and Social Security Number, so that this information would be automatically
assigned to each new claim you indexed. That way, you would only have to enter
variable information for each new claim indexed, such as Date or Time.
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Chapter 6. Locating documents and folders

In VisualInfo you locate documents and folders with the Search command. You perform
a search by looking for specific data in one or more key fields within a given index
class. For example, you could search the Claim class for all claims pertaining to a
customer named John Smith, or all claims pertaining to John Smith for the year 1995.
You could also search All Index Classes for all documents pertaining to a given
customer.

 Basic searches
To perform a basic search:

1. Press the Search button on the tool bar or select Basic Search  from the Search
menu. The Basic Search window opens.

Figure 18. Basic Search window

2. Click on the down arrow to the right of the Index Class  field to display the Index
Class list. This list contains all of the index classes you can access. Select the
index class you want to search. When you select an index class, the Basic Search
window displays the key fields for that class.

3. Type specific key field values for the items you want to locate. For example, you
might want to retrieve documents for a particular customer name, social security
number, or date. If you type values in more than one key field, the Client for
Windows only retrieves documents and folders that match all of the values you
type.

4. Click on OK to perform the search. A Table of Contents window opens, displaying
a list of all matching items from the index class you chose.
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By default, the VisualInfo system only returns the first 100 items that satisfy your search
criteria. To change this limit, see “Controlling the number of items in a table of contents”
on page 35.

"All Index Classes" search
You can select All Index Classes to search all classes. This is the default selection
when you open the Basic Search window. You can do this, for example, if you want to
retrieve all documents and folders pertaining to a particular customer or claim. If you
choose All Index Classes, you must enter a value in at least one key field to limit the
search.

 "NOINDEX" search
You can also select NOINDEX as your index class. Searching the NOINDEX class
returns all items in the fileroom that have not yet been indexed. By entering values in
the key fields, you can narrow your NOINDEX class search to items introduced by
particular users or input methods, or on particular dates.

 Advanced searches
Advanced search is a powerful and flexible tool for building and executing search
requests.

An advanced search query can specify groups for several index classes and set
different criteria for every one of them. For each index class, you create a search
expression using the search criteria (the attribute values) you want for that class.

You define your search request as a search form. You can immediately execute the
query, but you are also given the option to name and save that form for later use.
Having named search forms allows you to perform searches without re-defining them
every time. Depending on the kind of searches you usually do, you can use the
advanced search capability to accept parameters in search expressions. You can define
a certain search-form template and execute it with different concrete values at different
times.

Performing an advanced search
There are several ways to perform an advanced search:

� Press the Advanced Search button on the tool bar or select Advanced Search
from the Search menu. The Advanced Search - Form List dialog displays the list of
forms you have saved (Figure 20 on page 45). Select one or more forms and click
the Execute  button. If you have not saved any search forms yet, click New. (See
“Creating or editing an advanced search form” on page 45.)
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Figure 19. Search menu

� If you have an Advanced Search Form already open you can execute the search
from there.

� If your search form appears as a menu item, you can execute that form by
selecting the Search menu and clicking on the form name:

– If the menu item is an executable search form (designated by a circular “bull's
eye”), VisualInfo performs the search and displays the results.

– If the menu item is a search form template (designated by a cluster of
squares), VisualInfo displays a template for you to enter your search values.

Figure 20. Advanced Search–Form List

Creating or editing an advanced search form
1. Press the Advanced Search button on the tool bar or select Advanced Search

from the Search menu. The Advanced Search - Form List dialog displays the list of
forms you have saved.
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2. Select one or more forms and click Edit . To create a new form, click New. The
Advanced Search Form window opens.

Figure 21. Advanced Search Form window – General tab

3. Select the General  tab.

4. In the Comments  field, you can type a description of this search query.

5. Check Attach to the Search Menu List  if you want to save the form as an item on
the Search menu.

The Private  checkbox allows only users at your station to view the form. The
Public  checkbox allows other users on the network to view and use the form.
Currently only private forms are available.

6. Select the Search Query Builder tab to define your search criteria.

The Search Query Builder enables you to build a separate query for every index
class that you want to search as part of your advanced search. These separate
queries are referred to as Groups. For example, an advanced search form could
define a search with two groups, one that queried for insurance claims between
two given dollar amounts and one that queried for customers who had filed claims
within a given time period.

For each search group that you define, a tab displays above the query field at the
bottom of the Search Query Builder page.
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Figure 22. Advanced Search Form window – Search Query Builder

7. To add a group for a given index class to your search form, select that class from
the Index Class  drop-down list, which contains all available index classes. Click
Add Group . A tab for that group (index class) appears at the bottom of the page
with an edit field for the search string.

To delete a group from your form, select the group tab you want to delete and then
click Delete Group .

8. For each group, use the tools on that page to create the search expression
desired. For details and examples, see “Syntax of search expressions” on
page 48.

� Select attributes of the selected index class by double-clicking on them in the
Attribute list

� Select relationships between attributes and values by double-clicking on them
in the Relation list

� Type values into the Value field

� Click on the buttons (And, Or, Not, brackets)

� To create search form templates, insert variable parameters by clicking on the
variables in the parameter drop-down lists. For more information, see “Search
form templates” on page 50.

Instead of using the tools, you can manually type your search expression in the
edit field. You must follow the search expression syntax rules when typing the
search expression manually.

9. You can check the validity of the search expression by clicking Check . Select
Group  to check each group individually, or All Groups  to check all groups in the

  Chapter 6. Locating documents and folders 47



form. If the system finds errors in the search expression, a window displays a list of
what is wrong, what is expected, and where it is located.

10. When you are finished with the search expression for the group, click Done .

11. Click Execute  to perform the search and retrieve the information. If the system
finds an error in the search expression, an error window appears showing the
problem.

12. Click Save or Save As  to save the form. A window displays currently used form
names. Choose a new name or overwrite an old name, and click OK. The system
notifies you if the form name is already in use. If there are any errors, the system
displays an error message, showing the problem. You need to fix the search
expression before you can save it.

The Options tab of the Advanced Search Form window displays additional search
options, described on page 53.

Syntax of search expressions
Every search expression is built from the following elements:

 � Attributes

 � Relation symbols

 � Values

 � Logical operators

 � Brackets

The basic syntax for expressions has the form:

Attribute Relation ValueList

where ValueList is one or more Values (depending on the relation type) separated by at
least one space.

A search expression also can consist of several subexpressions, connected by logical
operators. Thus you can describe every possible condition you may want the attributes
to satisfy.

Examples:

/First name/ in "Ron" "Jim" "Bob" "Peter"

/Title/ like "Using the \ system"

/City/ = "San Francisco" AND
( /Profession/ = "Project manager" OR
 /Profession/ = "Programmer" AND ( /Years of experience/ > "5" OR
 /Education level/ = "University"))
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 Attribute names
An attribute name is the name of one of the key fields of the index class for the search
expression. The attribute name should be surrounded by / symbols, as follows:

/First name/

If / is one of the characters in the attribute name it should be doubled. For example,
“In/Out Document” should be entered as /In//Out Document/. If you use the Search
Query Builder tools to create the expression, they automatically double the / .

 Relation symbols
The valid relation symbols for search expressions are listed below. Except as noted,
each symbol takes one value and is valid for all types of attributes.

Relation
symbol

Meaning # of
values

Attribute
types

= Equal to 1 all

< Less than 1 all

> Greater than 1 all

<= Less than or equal to 1 all

>= Greater than or equal to 1 all

in Equal to one of the listed values 1 or more all

not in Not equal to one of the listed values 1 or more all

like Like (See “Wild cards” on page 54) 1 string

not like Not like (See “Wild cards” on page 54) 1 string

between Between two values (greater than the first, less
than the second)

2 all

not
between

Not between two values (less than the first,
greater than the second)

2 all

 Values
The search expression values are the attribute values you want to search on. A value is
surrounded by double quotes, for example "9/3ð/97". If the value itself contains a
quote, it should be doubled: "an ""excellent"" rating". When listing multiple values,
leave a space between each one.

If you use the Search Query Builder tools to create the expression, they automatically
double the quotes and add separating spaces and surrounding quotes. You still need to
type the values in the value edit field, entering every value on a new line.
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 Logical operators
Logical operators are used to connect two or more subexpressions into one expression.
The valid logical operators are listed below:

AND The whole expression is satisfied when both subexpressions are
satisfied

OR The whole expression is satisfied when at least one of the
subexpressions is satisfied

NOT Negates the condition that follows it

 Brackets
Brackets can be used to change the default order of a subexpression. You can use
them to ensure the desired order of precedence for relation symbols and logical
operators in your search query.

Example:

The following search expression:

/Name/ like "Ron\" OR /Name/ like "Bill\" AND
/Date of Birth/ between "1/1/6ð" "1/1/71"

returns all items for which the Name attribute begins with Ron, plus items beginning
with Bill for which Date of Birth is between the specified dates.

Adding a set of brackets yields the following search expression:

(/Name/ like "Ron\" OR /Name/ like "Bill\") AND
/Date of Birth/ between "1/1/6ð" "1/1/71"

This expression returns items for which the Name attribute begins with Ron or Bill, for
which Date of Birth is between the specified dates.

Search form templates
You can create an advanced search form with parameters and use the form as a
template. This way you just enter values for the parameters when you do a search
instead of building a new form for each similar search. You can add a template to the
Search menu. The VisualInfo system indicates that it is a template by using a cluster of
squares as an icon. (See Figure 19 on page 45.)

Creating a search form template
Create a search form template just as you would create an advanced search form. (See
“Creating or editing an advanced search form” on page 45.) Use a parameter wherever
you want to use variable information in your template.
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 Parameters
You can create up to 10 variable parameters for each type of search expression
element. The valid parameter names are as follows:

Attributes:  A1, A2, ..., A9, A0

Values: V1, V2, ..., V9, V0

Relations: R1, R2, ..., R9, R0

Logical Operators:  O1, O2, ..., O9, O0

Subexpressions:  E1, E2, ..., E9, E0

Surround subexpression parameters with square brackets ([ ] ) , all other kind of
parameters with braces ({ } ). If you do not type the search expression manually, but
use the Search Query Builder tools, they automatically add the braces and brackets.

 Examples:
/City/ = {V1} AND ( /Profession/ = "Project manager" OR
/Profession/ = "Programmer" AND ( /Years of experience/ > "5" OR
/Education level/ = "University"))

You can execute the query substituting a single city, such as "San Francisco" for V1,
or you can substitute a list of cities such as "San Francisco" "San Diego" "Chicago".
In this way, you do not need to build different search expressions every time, which are
identical except for the value of /City/.

In the same way you can use parameter {V2} instead of the value "5" for /Years of
experience/ and do different searches giving V2 different values.

You can also substitute a parameter for an expression: you could substitute [E1] for

( /Years of experience/ > "5" OR /Education level/ = "University")

Then you can execute a search replacing E1 with the same criteria or with different
criteria, such as:

 ( /Skills/ in "Basic" "C++" AND /Age/ between "26" "37").

Using a search form template
1. Select a search form template from the Search menu. Search form templates are

indicated by an icon that is a cluster of squares. The "Parameters for search form"
window opens. Each group (index class) in the template has a tab at the top of the
window.

2. Click on the tab for a group that you want to review. This displays the search
expression defined for that group. Below the search expression is a set of fields
where you can insert specific values for the parameters in the search expression. If
a syntax element includes a variable parameter, its fields are enabled.
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Figure 23. Parameters for Search Form window

3. For the enabled fields, select a variable parameter from the list on the left side of
the = sign, then enter the desired value on the right side. Depending on the
parameter, you can type a value or select one from a drop-down list. When you
type values, you must follow the syntax rules. You can fill in the parameters in any
order.

For a variable subexpression, you can type the subexpression or use the
subexpression tools. Open the tools window by clicking the Tools button in the
Expressions section. Hide the tools window by clicking the Hide button. For
instructions on using the tools, see “Creating or editing an advanced search form”
on page 45.

When you enter a value, the search expression changes immediately. The values
are retained as long as the dialog is open, even when you switch to another group.
You can change values at any time. For example, if you replace parameter A0 with
"Last Name, " you can later replace A0 with "First Name."

4. Click Check  if you want to test your search expression for syntax errors.

5. Repeat steps 3 and 4 for each group you want to review. You can also manually
edit the search expression for a group that does not use variable parameters.

6. After you finish entering values for your variable parameters, you have a fully
defined search form.

� To perform the search immediately, click Execute .

� To save your new search form for future use, click Save or Save as . This
adds the search form to the Search menu.
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When you execute a search, the dialog remains open in case you want to save the
search or perform another search using different values.

 Search options
The Options  button on the Basic Search window and the Options  tab on the
Advanced Search Form window both give you the same options to further expand or
limit your search. You can select or de-select check boxes to specify the type of item
(document or folder), workflow status, and suspension status of items you want to
search for. By default, all check boxes are selected. This means that a search will
return all items in the file room that fit your search criteria.

On the Options  tab on the Advanced Search Form window, each group of options
contains an All  button. When you click this button you automatically select all the
options in that group. In addition, an All  button near the top of the window enables
yuou to select all the options at once.

Figure 24. Search Options window for basic search
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Case sensitivity of searches
Depending on your environment, the search function can be case sensitive. If you are
logged onto to a library server for MVS or AIX , the search is case sensitive. To locate
an item, the values you type as your search criteria must match the uppercase and
lowercase letters of the indexing values for the item exactly as they are stored in your
database. For example, typing Smith will not locate an item with a stored value of
SMITH.

If you are logged onto a library server for OS/2 or NT , the search is not case sensitive
unless your system administrator has specified that it should be. Although the values
you type must match, the letters do not have to match the uppercase and lowercase
letters exactly as they are stored. Therefore, typing Smith as search criteria will still
locate an item that has a stored value of SMITH. Discuss with your system
administrator how you should specify search criteria in your environment.

 Wild cards
You can retrieve a group of documents and folders with similar key field values by
using a wildcard character. You can type a question mark (?) to substitute for a single
character or an asterisk (*) to substitute for any string of zero or more characters. For
example, you can type ?athy to search for Kathy and Cathy.

The wildcard characters can only be used in specific types of key fields. Your
VisualInfo system administrator assigns a type to each key field when it is defined. You
can use the ? wildcard character to substitute for a character in key fields that are
defined as either a fixed-string or variable-string type of field. You can use the *
wildcard character in variable-string fields. The Basic Search window indicates when a
wildcard character is valid for a specific key field by displaying it in parentheses next to
the input field. For example, key fields defined as variable-string fields will show both a
? and * next to the field because both types of wildcard characters are valid.

For an advanced search, you can use wildcard characters the same way you would use
them in a basic search. The Advanced Search windows do not indicate which wild
cards are valid for specific key fields. To check which wild cards are valid, select Basic
from the Search menu and then select an index class containing the key fields you
want to check. (You can cancel out of the basic search after you do this.)

You cannot use a wildcard character in the Date, Time , or Timestamp  field.

Table 2. Using wild cards in a basic search

Key Field
Search
Criteria Results

Claim Number *450 Returns a list of customers whose customer claim number
ends with “450”

Customer
Number

12???67 Returns a list of customers with 7 digit account numbers
that begin with “12” and end with “67”

Customer Name John* Returns a list of customers whose name begins with “John”
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Chapter 7. Workbaskets, folders, and workflows

Workbaskets and folders are both containers for items stored in the VisualInfo system.
The main difference between workbaskets and folders lies in the uses to which you put
them.

You can think of workbaskets as stationary locations in your VisualInfo system that can
represent individuals, departments, or processes. Folders are collections of items that
can be moved between these workbaskets for processing.

The planned route by which a folder or document moves between workbaskets is a
workflow. Your system administrator defines the sequence of workbaskets in a
workflow. The workflow electronically routes the document to the next appropriate user
in the sequence.

Note:  Workflows are not available with VisualInfo for AS/400.

Menus for workbaskets, folders, and workflows
Working with workbaskets, folders, and workflows means working with the contents of
these items, namely documents and folders. To work with folders and documents, you
generally use three menus:

 � Selected
 � Process
 � Workbasket

 Selected menu
You can use the Selected menu to select or deselect items in the active TOC, or you
can perform actions that will affect all selected items. You can index a folder or
document, add notes to a folder or document, add folders or documents to another
folder or workbasket, or export a document. The Selected menu will act upon an open
document if it is in the active window.

 Process menu
The Process menu enables you to perform workflow actions on an open document or
selected documents and folders in a TOC.

 Workbasket menu
The Workbasket menu is enabled when you are working in a system-assigned
workbasket. You can use it to move from one item to the next in the workbasket. For
details, see, “System-assigned workbaskets” on page 56.
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 Workbaskets
Depending on your VisualInfo implementation, a workbasket typically represents a
collection of folders or documents that requires a specific, well-defined processing step.

 System-assigned workbaskets
When setting up your system, the system administrator defines certain workbaskets as
system-assigned. When you open a system-assigned workbasket, the items in that
workbasket are presented to you one by one, in the order of their processing priority.
You do not see a Table of Contents for these workbaskets and you do not need to
select and open each item. The name of the system-assigned workbasket where you
are working appears on the right side of the status line at the bottom of the window.

When you finish processing an item in this workbasket, you use the Workbasket menu
to move to the next item.

Note that if you do not do anything to remove the item from the workbasket (such as
indexing it or routing it to another workbasket), you will get the same item back.

The Workbasket menu contains three choices:

Next
Displays the next highest-priority item

Save and Next
Saves any indexing changes, note log changes, or annotations you have added
to the current item and displays the next item

Delete and Next
Deletes the current item and displays the next item. The item is deleted from the
VisualInfo system.

Items are bypassed if they are checked out to another user or suspended.

 User-selected workbaskets
Your system administrator defines certain workbaskets as user-selected. A Table of
Contents appears when you open these workbaskets. When a workbasket contains
items from more than one index class, the Table of Contents contains a page for each
index class. You can select an index class tab and display the items within that class.

Working with workbaskets
When you are working with a workbasket, you can:

 � Open it

� Add items to it

� Display a count of items in it

� Change the priority of the items in it

� Remove an item from it
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Opening a workbasket
1. From the File menu, select Open Workbasket . The Select Workbasket window

opens, enabling you to select a workbasket from the list of previously defined
workbaskets.

2. Select the workbasket you want and click the OK button. The Table of Contents
opens for the workbasket you selected.

You can open as many workbaskets as you need.

Figure 25. Select Workbasket window

Adding items to a workbasket
1. From a Table of Contents window select the items to be routed to a Workbasket.

2. From the Selected menu, select Add to Workbasket . This opens the Select
Workbasket window.

3. Select the workbasket to which you want the item added. If an item is in a
workflow, the next workbasket in the workflow is indicated as the default selection.

4. When you add items to a workbasket, the Select Workbasket window enables you
to change their priority. In the Priority  field, type a number; 1 is the lowest priority
you can assign and 31,999 is the highest. If you do not enter a priority, the default
priority for the index class will be used. The default priority is specified by your
system administrator. For more information, see “Changing the priority of items in a
workbasket” on page 58.

5. Click on the OK button. This adds the selected item to the designated workbasket.
If the item was already in a workbasket, it is transferred to the new workbasket.
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Displaying a count of items in a workbasket
By default, only the first hundred items in any Table of Contents display in a window. If
there are more than a hundred items in a TOC, a message will tell you how many items
are in the TOC.

If you want to know in advance how many items are in each workbasket, do the
following:

1. From the Options menu, select Preferences . This opens the Operator Preferences
window.

2. Under Workbasket , select the check box for Display the number of items in
each workbasket .

When the display option is selected and you open the Select Workbasket window, a
count of items appears after each workbasket name.

Displaying the number slows processing speed, so if speed is an issue, you might want
to disable this option. Select Preferences  from the Options menu and click on the
Workbasket check box again. This disables the item count.

Changing the priority of items in a workbasket
You can look at or change the priority of a document or folder. Changing the priority of
a document or folder moves it up or down in the processing order in a system-assigned
workbasket.

1. Select a folder or document in a TOC window.

2. Select Priority  from the Process menu.

3. Type a priority value for the document or folder in the Priority  entry field. You can
specify a value from 1 to 31,999, where 1 is the lowest priority (processed last) and
31,999 is the highest priority (processed first).

4. Click on the OK push button.

You can also change the priority of an open document:

1. Select Priority  from the Process menu.

2. Type a priority value for the document or folder in the Priority  entry field. You can
specify a value from 1 to 31,999, where 1 is the lowest priority (processed last) and
31,999 is the highest priority (processed first).

58 VisualInfo Client for Windows User’s Guide  



 Folders
A folder is a collection of VisualInfo items that can include documents and other folders.
Folders can be created and stored automatically, or they can represent the results of a
search. When you open a folder, it is represented by its Table of Contents, from which
you can select items to work with. For a detailed description of working with Tables of
Contents, see Chapter 4, “Using tables of contents” on page 29.

You can do the following things with folders:

� Index a folder

� Open a folder

� Create a new folder

� Add items to an existing folder

� Add notes to a folder

� Delete a folder

For information on indexing a folder, see Chapter 5, “Indexing documents and folders”
on page 39. For information on deleting a folder, see “Removing and deleting items” on
page 38.

Opening a folder
You can open any folder that is listed in an open Table of Contents. Do one of the
following:

� Double-click anywhere on the row representing the folder
� From the File menu, select Open

Creating a new folder
1. Select one or multiple items from an existing Table of Contents, or select an open

document window.

2. Select Add to New Folder  from the Selected menu. The Edit Index window opens.

3. Click on the down arrow to the right of the Index Class  field. This opens the list of
available index classes.

4. Select an index class from the list. The key fields will be displayed for the selected
index class.

5. Type the key field index values for the new folder and click on OK.

The VisualInfo system creates a new folder indexed with the index class and key
field values you entered. The folders and documents you selected are placed in
this new folder. The new folder's TOC opens automatically.
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Adding items to an existing folder
1. Select the items you want to add to an existing folder.

2. From the Selected menu, select Add to Folder . This opens the Basic Search
window.

Figure 26. Basic Search window

3. Click on the down arrow to the right of the Index Class  field. This opens the list of
available index classes.

4. Select the index class that is assigned to the target folder. The key fields will be
displayed for the selected index class.

5. Type one or more key field values that are assigned to the target folder and click
on OK.

6. If multiple items result from the search, the Select Folder dialog box opens. Select
the folder or folders to add your items to.

 Annotating folders
You can add notes to a folder or view notes that other people have added. To add
notes, do the following:

1. Open a folder.

2. From the Selected menu, select Folder Notes . The Notes window opens.

You can now type your note much as you would on the Windows Notepad or any
other text editor. The client application automatically generates the date and user
ID information for you. Your note is appended below the existing notes for the
folder.

3. If you want to cancel your note, click Cancel .

4. When you are finished, click OK. Your note is saved in the note log for the folder.
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You can view the note log at any time by following the procedure for adding notes. The
Notes window enables you to read the entire note log. When you finish looking at the
note log, click on Cancel .

You can export the note log when you export a folder. See “Exporting” on page 26 for
more information.

Figure 27. Notes window

 Workflows
A workflow is a predefined path that a document or folder follows through a series of
workbaskets. When you finish processing a document or folder, you can route the item
to the next workbasket in the workflow, move it to another workflow, mark it as
completing the workflow, or remove it from the workflow. For example, a typical
workflow might include an indexing workbasket, a processor's workbasket, and a
reviewer's workbasket. To be assigned to a workflow, a document or folder must meet
the following conditions:

� Available for access by your user ID
� Not checked out to another user
� Not currently opened by another user

Note:  Workflows are not available with VisualInfo for AS/400.

The Process  menu option gives you access to a variety of processing commands. You
can select Start Workflow, Change Workflow, Complete Workflow,  or Remove from
Workflow  from the Process menu if you are working with one or more items highlighted
in a folder or workbasket. Workflow options from the Process menu apply to all folders
and documents highlighted in the TOC window.
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You can also select Start Workflow, Change Workflow, Complete Workflow,  or
Remove from Workflow  from the Process menu if you are working with an open
document in the Document window. The workflow options apply only to that single
document.

The commands on the Process Workflow  menus enable you to do the following:

� Start items in a workflow
� Move items to a different workflow
� Complete a workflow for an item
� Remove items from a workflow
� Suspend and reactivate items
� Check items out and in (see “Checking documents and folders out and in” on

page 36).
� Assign priorities to items (see “Changing the priority of items in a workbasket” on

page 58).

Moving items through workflows
You can start an item in a workflow, change an item's workflow, mark an item as
completing a workflow, or remove an item from a workflow. For all of these procedures,
select Start Workflow, Change Workflow, Complete Workflow,  or Remove from
Workflow from the Process menu .

Starting a workflow
To start a document or folder in a workflow:

1. Select the item.

2. Select Start Workflow  from the Process menu.

3. Select a workflow from the list of available workflows.

4. To change the priority of the item in the workflow, type a number in the Priority
field; 1 is the lowest priority you can assign and 31,999 is the highest (for more
information, see “Changing the priority of items in a workbasket” on page 58).

5. Click on the Start  button to start the item in the workflow.

Your system administrator can also automatically start a document or folder in a
workflow based on its index class definitions.

If an item is already in a workflow, the Start Workflow  command is unavailable.
Instead, you can transfer the item by using the Change Workflow  command.

Changing a workflow
To move a document or folder to a different workflow:

1. Select the item.

2. Select Change Workflow  from the Process menu. The Change Workflow window
opens.

3. Select a workflow from the list of available workflows.
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4. To change the priority of the item in the workflow, type a number in the Priority
field; 1 is the lowest priority you can assign and 31,999 is the highest (for more
information, see “Changing the priority of items in a workbasket” on page 58).

5. Click on the Start  button to start the item in the new workflow.

Completing a workflow
You can mark a document or folder as complete before or after it is finished moving
through all of the workbaskets in a workflow. You might choose to mark an item as
complete if the remaining steps in the workflow are no longer necessary. To mark a
document or folder as complete:

1. Select the item.

2. Select Complete Workflow  from the Process menu. A dialog box opens, asking if
you want to remove the selected item(s) from their workbasket(s) when removing
them from the workflow environment.

3. Click on Yes if you want to remove the selected item from the workbasket.

Click on No if you want the selected item to remain in the workbasket even though
it is no longer in the workflow.

Removing documents and folders from a workflow
You can remove a document or folder from the workflow without marking it as
complete. You might choose to remove an item that still requires processing, but not
the steps that were predefined by the current workflow. To remove a document or
folder from the workflow:

1. Select the item.

2. Select Remove from Workflow  from the Process menu. A dialog box opens,
asking if you want to remove the selected item(s) from their workbasket(s) when
removing them from the workflow environment.

3. Click on Yes if you want to remove the selected item from the workbasket.

Click on No if you want the selected item to remain in the workbasket even though
it is no longer in the workflow.

Suspending documents and folders
Suspending a document or folder makes it temporarily unavailable for normal
processing. You can suspend a document or folder until a specified date and time. In
addition, you can suspend a folder until documents and folders of a selected index
class are added to it. You can suspend a document or folder if it meets the following
conditions:

� Available for access by your user ID
� Not checked out to another user
� Not currently opened by another user
� Not already suspended
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Suspending a document
To suspend a document:

1. Select the document by opening it in a document window or highlighting it in a
Table of Contents.

2. From the Process menu, select Suspend . The Suspend window opens.

Figure 28. Suspend window

3. Specify the date that you want the document activated in the Activation date  entry
field. This field is required.

Note:  For your convenience, you can enter a two-digit year. However, the Client
for Windows assumes that you mean a year in the current century.
Therefore, if your activation date is in the next century, you need to enter a
four-digit year.

4. Specify the time that you want the document activated in the Activation time  entry
field. This field is required.

5. From the Destination workbasket  list, select the workbasket where you want to
send the document when it is activated. The destination workbasket is optional.

6. Click on OK.
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Suspending a folder
To suspend a folder until a particular date and time:

1. Select the folder by opening it and clicking on its selection icon, or by highlighting it
in a Table of Contents window.

2. From the Process menu, select Suspend . This opens the Suspend Folder window.

Figure 29. Suspend Folder window

3. Specify the date that you want the folder activated in the Activation date  entry
field. This field is required.

Note:  For your convenience, you can enter a two-digit year. However, the Client
for Windows assumes that you mean a year in the current century.
Therefore, if your activation date is in the next century, you need to enter a
four-digit year.

4. Specify the time when you want the folder activated in the Activation time  entry
field. This field is required.

5. From the Destination Workbasket for Timed Activation  list, select the
workbasket where you want to send the folder when it is activated. The Client for
Windows sends the folder to this destination workbasket if the folder is activated
because the activation date and time are reached.

6. Click on the OK push button.
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You can also specify that you want a folder activated if it receives one or more
documents belonging to specified index classes. For example, you might want to
activate a customer folder and route it to a special workflow if it receives a claim
document plus a medical report. To activate a folder on receipt of one or more
documents, do the following:

1. On the Suspend Folder window, select the Activate on Class Receipt  check box.

2. Select one or more index classes from the Awaited Classes  list. These represent
the index classes of the documents or folders that can cause the suspended folder
to be reactivated. You can choose up to 8 classes.

3. Choose the All Selected  or Any Selected  radio button.

� All Selected  means that the suspended folder is reactivated only when it
receives documents or folders belonging to all the selected classes.

� Any Selected  means that the suspended folder is reactivated if it receives
documents or folders belonging to any of the selected classes.

4. From the Destination Workbasket for Class Activation  list, select the
workbasket where you want to send the folder when it is activated. The Client for
Windows sends the folder to this destination workbasket if the folder is activated
because documents or folders of the required classes are received.

5. Click on the OK push button.

The folder is activated when the required documents or folders are received. If they are
not received prior to the activation date and time, then the folder is activated at the
activation date and time.

Activating a document or folder
To activate a document or folder before its activation date and time:

1. Select the item.

2. From the Process menu, select Activate . This activates the document or folder.

66 VisualInfo Client for Windows User’s Guide  



Chapter 8. Viewing and annotating documents

This chapter describes viewing and annotating documents. To view or annotate a
document, you first need to open it. You can do this in several ways:

� Double-click on a document in a Table of Contents window
� Select a document and click on Open  from the File menu
� Select a document in a TOC and click the Open Selected Item  button on the

toolbar
� Press Ctrl + O on your keyboard

Note:  To view a document, you must have DOC TOC privileges assigned to you. If
not, when you try to open a document, it will be opened but not displayed in the
window. You will be able to view the document's index values but not the actual
document.

Note:  You can not view documents whose format is non-interlaced YCbCr.

Figure 30. The document window

The document window
The image that you are viewing is contained in a document window that opens inside
the Main Window. You can maximize the document window, scroll it, or size it as you
would any other window. When a document window is the active window, the Main
Window menu bar and tool bar are replaced by a document menu bar and toolbar. In
addition, the document window can display a thumbnail bar that gives you small
“thumbnail” representations of all the pages of the open document.
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You can have multiple document windows open at the same time.

Document menu bar
When a document is open, some of the menus displayed on the Main Window menu
bar change. The document menus enable you to change the way you view your
document and make annotations on your document. You can index your document from
the Selected menu or perform workflow operations from the Process menu. (Workflow
operations are also available on documents that are not open.) For details, see “Main
Window menus” on page 9.

 Document toolbars
The document toolbars display below the menu bar. They enable you to perform
actions by clicking on representative buttons. These provide a quick way for you to
access the commands that you use most frequently from the View menu and Comment
menu.

Two document toolbars are available. The Document Bar enables you to do things such
as rotate the document pages and zoom in on the document. (See “Viewing a
document” on page 69.) The Comment Bar enables you to add annotations to the
document such as notes or highlights. (See “Annotating documents” on page 72.)

You can show or hide the toolbars by selecting the View menu and clicking Document
Bar  or Comment Bar .

Figure 31. Document with thumbnail bar
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 Thumbnail bar
The thumbnail bar enables you to preview all the pages of the open document.
Figure 31 on page 68 shows a document with the thumbnail bar displayed. You can
move quickly to a page you want to view by clicking on its thumbnail. You can show or
hide the thumbnail bar selecting the Options menu and clicking Thumbnail Bar.

Viewing a document
You can open a document using any of the methods described on page 67. When you
open a document, the first page is automatically displayed.

You can also open a document in Browse mode. Select the document in a Table of
Contents. Then choose Browse  from the File menu. When you browse a document,
you can view it but you cannot index or delete it. In addition, you can view annotations,
but you cannot add, delete, or edit them.

The following sections describe features that help make it easy to work with your
documents.

� Moving between pages
� Rotating a page
� Enhancing an image
� Inverting an image

 � Fitting pages
 � Zooming

The rotate, enhance, and invert functions are not available for non-image documents

Moving between pages
Once you have opened a document, you can use the commands on the View menu to
easily move between the pages of your document:

Go to Page
When you have opened a document and know the number of the page you
want to view, you can use the Go to Page  command. In the Go To Page
dialog box, type the page number of the page you want to display.

You can also bring up the Go To Page dialog box by pressing the Ctrl+G
shortcut keys.

Previous Page
Use this command to go to the page before the one you are viewing. You
can also move to the previous page by using the Page Up key.

Next Page
Use this command to go to the page after the one you are viewing. You
can also go to the next page by using the Page Down key.

First Page
Use this command to go to the first page in the document you are viewing.
You can also go to the first page by using the Home key.
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Last Page
Use this command to go to the last page in the document you are viewing.
You can also go to the last page by using the End key.

Rotating a page
Under some circumstances you might want to rotate the page you are viewing.
Examples are a page that has been inadvertently scanned upside down or a
newspaper clipping that could only fit through the scanner by turning the clipping 90
degrees.

When you rotate a page, it is only rotated for the current viewing session.

To rotate a page, first click on the page you want to rotate. Then do one of the
following:

� Click on the appropriate Toolbar Button
� Press the * key on the numeric keypad to rotate the page clockwise
� Press the / key on the numeric keypad to rotate the page counterclockwise
� From the View menu, select Clockwise  or Counterclockwise

Enhancing an image
Select Enhance  from the Image menu to improve the quality of the document image. A
checkmark appears next to the Enhance menu item to indicate that you are in
enhanced mode. All subsequent documents are automatically displayed in enhanced
mode until you turn off the Enhance option by clicking on Enhance  again.

The Enhance option does not apply to non-image formats such as ASCII or word
processor data formats. Therefore, a checkmark does not appear next to the Enhance
menu item when you view these kinds of documents.

The Enhance option affects the display of the document and does not change the
stored document itself.

Note:  Initially presenting an image in enhanced mode can increase the amount of time
required to display the document.

Inverting an image
The Invert  command reverses the bi-tonal (black and white) areas of a page for the
current viewing session. Sometimes documents are more legible if the black and white
parts of a page are reversed. This is especially true if light type is used on a dark
background. Also, many OCR engines are unable to interpret white text.

To invert an image:

1. Open the document that contains the page you want to invert.
2. Select the page.
3. From the Image menu, select Invert .
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 Fitting pages
There are a variety of options for fitting pages in the window or a windowpane. Pages
you view in the client application can be of different sizes because original documents
can have different sizes or be scanned in different resolutions. You can fit pages to
your window by using commands from the Fit  option of the View menu.

Normal
The Normal command prevents page size from changing when the window size
is changed.

Page Width
The Page Width command sizes a page so that the left and right edges of the
page fit the borders of the window. You can also click on the Page Width toolbar
button.

Page Length
The Page Length command sizes a page so that the top and bottom edges of the
page fit the borders of the window. You can also click on the Page Length toolbar
button.

Page Fit Within
The Page Fit Within command sizes a page so that the entire page fits within the
window. When Page Fit Within is selected, you can rotate the page or resize the
window and the entire page will always remain in view.

Window Width
The Window Width command sizes a page so that the left and right window
borders contact the edges of the page.

Window Length
The Window Length command sizes a page so that the top and bottom window
borders contact the edges of the page.

 Zooming
Zooming means enlarging or reducing the page you are viewing. You can change the
size of a displayed page with the Toolbar, the keyboard, or the menus.

Zooming with the toolbar
You can use the toolbar to change the zoom of a display in the following three ways:

� Click on the Zoom In button to enlarge the page display.
� Click on the Zoom Out button to reduce the page display.
� Select a size or enter a value in the Zoom To option box.

Zooming with the keyboard
You can use the keyboard keypad to change the zoom of a display in the following
ways:

� Press + on the keypad to enlarge the page display.
� Press - on the keypad to reduce the page display.

  Chapter 8. Viewing and annotating documents 71



Zooming with menus
You can use the menus to change the zoom of a display by the following methods.

To use the Zoom menu commands:

1. Click on the View menu.
2. Click on Zoom In  or Zoom Out .

To use the Zoom dialog box:

1. Click on the View menu.
2. Click on the Zoom To option.
3. In the Zoom dialog box, select the zoom percentage you want. Use the up and

down arrow keys to increase or decrease the percentage.

Figure 32. Zoom dialog box

 Annotating documents
Annotations are comments and marks that you can use to call attention to certain areas
of a document or to record important information. The annotations you create are not
inserted into the document, but are placed on a layer above the document. This
process enables you to work with a document without losing the integrity of the original.

To understand this process, think of a paper document. Now imagine a sheet of glass
placed over the document. When you annotate the document, it is like writing on the
glass; it looks like you are writing on the original, but the original is unchanged.
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The annotation tools
A wide variety of tools are available for you to annotate your documents in different
ways. You can access these tools from the Comment toolbar or the Comment menu:

 � Pen

 � Highlighter

 � Box

 � Circle

 � Line

 � Arrow

 � Text

 � Stamp

 � Note

The following sections describe the annotation tools and show their toolbar buttons.

You can also move your annotations or change their appearance. For detailed
information, see “Working with annotations” on page 77 and “Changing the properties
of annotations” on page 80. If you want to use an annotation tool without having to
reselect it each time, right mouse click on your document to display the pop-up menu,
and choose Keep Selected .

 Pen

The Pen tool enables you to annotate your document by drawing free-form lines.

1. Click the Pen button on the toolbar or select Pen from the Comment menu.

2. Use your mouse to position the cursor where you want to start drawing.

3. Hold down the left mouse button.

4. Use the cursor like a pen to create a line over your document

5. Release the left mouse button when you want to end the line.

6. Use the pen property sheet to change your lines’ width, color, transparency, or
other properties.

7. Repeat this procedure for each line you want to draw.
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 Highlighter

The Highlight tool enables you to mark parts of your document with rectangular
highlights of different colors and sizes.

Highlights work best with high-contrast images like black and white, because the
highlight colors were chosen for their transparency. Highlights can be difficult to see on
color or grayscale documents, particularly if the portion of the image underneath the
highlight is dark.

1. Click on the Highlighter button on the toolbar or select Highlighter  from the
Comment menu.

2. Use your mouse to position the cursor where you want to highlight.

3. Hold down the left mouse button.

4. Move the cursor over the area you want to highlight.

5. Release the left mouse button when you want to end the highlight.

6. Use the highlight's property sheet to change its size, color, transparency, or other
properties.

7. Repeat this procedure for each highlight you want to draw.

 Box

The Box tool enables you to draw a rectangular box around portions of your
document.

1. Click the Box button on the toolbar or select Box from the Comment menu.

2. Use your mouse to position the cursor at one corner of the area you want to
enclose with a box.

3. Hold down the left mouse button.

4. Move the cursor over the area you want to enclose.

5. Release the left mouse button where you want to place the opposite corner of the
box.

6. Use the box's property sheet to change its width, height, color, transparency, or
other properties.

7. Repeat this procedure for each box you want to draw.
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 Circle

 The Circle tool enables you to draw a circle or oval around portions of your document.

1. Click the Circle button on the toolbar or select Circle from the Comment menu.

2. Use your mouse to position the cursor at one corner of the area you want to
surround with a circle or oval.

3. Hold down the left mouse button.

4. Move the cursor over the area you want to enclose. Your cursor movements define
a bounding box that contains the circle or oval you are creating.

5. Release the left mouse button when your circle or oval is the right size and shape.

6. Use the circle or oval's property sheet to change its width, color, transparency, or
other properties.

7. Repeat this procedure for each circle or oval you want to draw.

 Line

The Line tool enables you to draw a line between any two points on your document.

1. Click the Line button on the toolbar or select Line from the Comment menu.

2. Use your mouse to position the cursor at the starting point for your line.

3. Hold down the left mouse button.

4. Move the cursor to the end point for your line.

5. Release the left mouse button.

6. Use the line's property sheet to change its width, color, transparency, or other
properties.

7. Repeat this procedure for each line you want to draw.

 Arrow

The Arrow tool enables you to draw an arrow at any location on your document.

1. Click the Arrow button on the toolbar or select Arrow from the Comment menu.

2. Use your mouse to position the cursor where you want the back end of your arrow.

3. Hold down the left mouse button.

4. Move the cursor to where you want the point of your arrow.

5. Release the left mouse button when the arrow is in the right position.

  Chapter 8. Viewing and annotating documents 75



6. Use the arrow's property sheet to change its color or transparency, the size and
shape of its head, or other properties.

7. Repeat this procedure for each arrow you want to draw.

 Text

The Text tool enables you to create text at any point on your document. Text
annotations differ from note annotations. Text annotations lie directly over your
document, while notes are contained in a rectangle similar to a "sticky note."

1. Click the Text button on the toolbar or select Text from the Comment menu.

2. Use your mouse to position the cursor where you want your text annotation to
begin.

3. Type your text as you would with a word processor.

4. When you have finished the text, click elsewhere on the document or press Enter
to indicate that you have finished.

5. Use the text annotation's property sheet to change its font size and style, color,
transparency, or other properties.

6. Repeat this procedure for each text annotation you want to add.

 Stamp

The Stamp tool enables you to create an annotation similar to a "rubber stamp" at any
point on your document. You can design your own stamp by opening the property
sheet for a new or existing stamp annotation, changing its text and other properties,
and clicking the Save button. This adds your new stamp to the list of choices that
display whenever you create a stamp annotation.

1. Click the Stamp button on the toolbar or select Stamp  from the Comment menu.

2. Use your mouse to position the cursor at the upper left corner of the area where
you want the stamp.

3. Click the left mouse button. This opens a list of available stamps.

4. Double-click on the name of the stamp you want to use. The stamp is placed on
your document.

5. Use the stamp's property sheet to change its text, color, transparency, border
width, border angle, or other properties. To change the size of a stamp, change its
font size.

If you want to save your changes as a new stamp, click Save.

6. Repeat this procedure for each stamp you want to use.
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 Notes

The Note tool enables you to attach a note of any size to any location on your
document. When you are working within a note, you can enter text as you would with a
standard text editor. Note annotations differ from text annotations. Notes are contained
in a rectangle similar to a "sticky note," while text annotations lie directly over your
document.

1. Click on the Note button on the Comment toolbar or select Note  from the
Comment menu.

2. Click at the place on the document where you want the note to appear.

3. Type your text into the note. You can use standard text editor functions such as
text selection, deleting, and cursor placement.

4. To create another note, click anywhere on the document outside the first note.

5. When you are finished creating notes, do one of the following:

� Click the Note button on the toolbar
� Select Note  from the Comment menu
� Press Alt + F4 on your keyboard

Working with annotations
The VisualInfo Client for Windows gives you several tools for working with the
annotations that you add to your documents. Some of your options are: showing,
selecting, deleting, erasing, bringing to front, and sending to back.

Showing and hiding annotations
You can choose to display or hide annotations when you display a document. You can
toggle between hidden and displayed in three ways:

� Click the Show/Hide button on the Document toolbar.

� From the Comments menu, select Show Comments .

� Click anywhere on the document and then click on the right mouse button to open
a pop-up menu. Select Comments , then select Show Comments .
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 Selecting annotations
The Selection toolbar button has two positions: lowered and raised. Lowered is the
select position; raised is the deselect position.

Select position (lowered)

Deselect position (raised)

When this button is lowered or in the select position, clicking with the left mouse button
on an annotation will select it. When this button is raised or in the deselect position,
clicking with the left mouse button on an annotation will select the document under it.

Changing the size of annotations
Any time after you create an annotation, you can change its size.

1. Make sure the selection button is in the down (select) position.

2. Click with the left mouse button on the annotation you want to resize. A sizing box
appears around the annotation.

3. Move the cursor over the sizing handles until the cursor becomes a double-headed
arrow symbol. The sizing handles are at the corners and the middle of each side.

For most annotations, you can use any of the sizing handles. However, for notes,
you can only use the sizing handles on the right and bottom sides of the box.

For stamps, the only way to change the size is to change the size of the stamp’s
font on its property sheet.

4. Hold down the left mouse button and move the mouse to drag the sizing handle.
Dragging on a handle at a corner resizes the entire box. Dragging on a handle in
the middle of a side moves that side only.

Changing the location of annotations
You can also change the location of an annotation at any time.

1. Make sure the selection button is in the down (select) position.

2. Click with the left mouse button on the annotation you want to move. A sizing box
appears around it.

3. Move the cursor into the sizing box, so that the cursor becomes a crossed arrows
symbol.

4. Hold down the left mouse button and move the cursor to drag the annotation.
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 Deleting annotations
You can quickly delete annotations.

To delete a single item:

1. Make sure the Selection button is in the select (lowered) position.
2. Click on the annotation to be deleted. A sizing box should appear around it.
3. Press the Delete key or choose Delete Selected  from the Comment menu.

To delete multiple items:

1. Select Eraser  from the Comment menu, or click on the Eraser toolbar button.
2. Place the cursor cross-hairs over the annotation you want to erase.
3. Click with the left mouse button. The item is deleted.
4. Repeat this procedure for each item you want to delete.
5. To end the Erase mode, click the Erase button to deselect it.

Bringing to the front
When you have several overlapping annotations, you can use the Bring to Front
command to put one in front of the others.

1. Make sure the selection button is in the down (select) position.

2. Click to select the item you want to place in front. When you select an item, a
sizing box appears around it.

3. Select the Bring to Front  command from the Comment menu, or click on the Bring
to Front button.

If you have three or more overlapping items, Bring to Front  moves the selected
item forward by one layer. To move the selected item all the way to the front, hold
the Ctrl key while clicking the Bring to Front button.

4. Click elsewhere on the screen to deselect the item.

Sending to the back
When you have several overlapping annotations, you can use the Send to Back
command to put one behind the others. This command is useful when you have one
item completely covering another and you want to select the lower one. By sending the
top item to the back, you can select the item you want.

1. Make sure the select button is in the down (select) position.

2. Click to select the item you want to send to the back. When you select an item, a
sizing box appears around it.

3. Select the Send to Back  command from the Comment menu, or click on the Send
to Back button.
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If you have three or more overlapping items, Send to Back  moves the selected
item backward by one layer. To move the selected item all the way to the back,
hold the Ctrl key while clicking the Send to Back button.

4. Click elsewhere on the screen to deselect the item.

Changing the properties of annotations
After you have made an annotation, you can change the color, width, and other
properties of the mark. You make these changes with the annotation's Property Sheet.

Note:  Changes to an annotation's font, color, or transparency are not necessarily
retained when you end your current viewing session.

To change the properties of an annotation:

1. Make sure the selection button is in the down (select) position. If not, click on the
button.

2. Select the annotation you want to change, then do either of the following:

� Select Property Sheet  from the Comment menu.

� Click with the right mouse button on the annotation to open its pop-up menu.
From the pop-up menu, select Property Sheet .

3. On the property sheet, select the properties you want.

� To see through your annotations to the underlying document, check the
Transparent  option.

� To reduce the time required to process marks, uncheck Draw While Moving
and Apply Now .

When Draw While Moving  is checked, your annotations will be redrawn
continuously while you create, move, or resize them. We recommend that you
leave this option unchecked.

When Apply Now  is checked, property changes you make will affect your
notes immediately. When Apply Now  is unchecked, property changes you
make will not change your marks until you click OK.

� To change the color of your annotations, click on the button beside the color
box, click on a color in the Color dialog box, and click OK. You can select one
of the predefined colors or define a custom color.

� Select other properties that are specific to the type of annotation you are
working with.

4. If you want your property selections to be the default properties for future
annotations, click on the Set Default  button.

5. When you are done, click OK.
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The property sheet also includes an object name. This is a unique identifier that the
system assigns to your annotation. You cannot change the object name.

Viewing non-image documents
Non-image documents are documents that are not stored in a graphic format. These
include ASCII documents, word processor documents, and spreadsheets. You can view
and manipulate non-image documents in the same way as image documents (with
certain restrictions). You can also launch a non-image viewer from the Client for
Windows.

Using the document viewer with non-image documents
You can open a document window for non-image documents in the same way as you
would for image documents. However, you need to be aware of certain restrictions that
apply to viewing non-image documents:

� Annotations made with a VisualInfo client on one operating system do not
necessarily appear in the same position when you display the document on a
different operating system. This is because the displayed and printed presentations
of non-image documents can differ from one operating platform to another.

� When you print a non-image document, annotations do not necessarily appear in
the same place on the printed version of the document as on the displayed
version.

� The enhanced image mode does not work on non-image documents.
(See“Enhancing an image” on page 70 .)

� When you initially display an ASCII document, text lines can appear to overlap. To
correct this, zoom in on the document by pressing the + key or using the Zoom In
command from the View menu. (See “Zooming” on page 71.)

Using a non-image viewer
You can launch a non-image viewer from the Client for Windows. You need a
non-image viewer to view non-image documents containing DBCS characters, such as
Japanese, Chinese, or Korean text documents.

Any changes you make while viewing the document in the non-image viewer will not be
saved. In addition, you must manually close the non-image viewer application. The
Client for Windows does not close the this application when you close the document
from the File menu.

Configuring the VIC.INI file for a non-image viewer
Before using a non-image viewer program, add an entry for the program to the VIC.INI
file, located in the \WINDOWS subdirectory for Windows 95 and 3.1, and in the
appropriate \WINNT subdirectory for Windows NT. Use the following format for your
entry:

[Content Classes]
{CCName}={ext}, {Program Name} {Optional Parameters}
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where{CCName} = the content class name. This is the same name used to define the
"External Data Format" in the VisualInfo System Administration program. {CCName} is
not case sensitive.

{ext} = the 3–character extension expected by the non-image viewer program.

Note:  The comma is required after {ext}.

{Program Name} = the location (path and file name) of the non-image viewer program.

{Optional Parameters} = any additional parameters for the non-image viewer.

For example, to configure the VIC.INI file for using Microsoft Word, you might use the
following entry:

[Content Classes]
msword=doc, c:\msoffice\word.exe

Launching a non-image viewer
For a non-image viewer program to work correctly with the Client for Windows, you
must be able to launch the program from the command line using a command in the
following form:

{Program Name} {Optional Parameters} {filename}.{ext}

 where {filename} is the name of the file you want to view in the non-image viewer,
and {Program Name}, {Optional Parameters}, and {ext} are the values you defined in
the VIC.INI file.

For example, to use the Client for Windows to open a file named sample.doc in
Microsoft Word, you might use the following command:

c:\msoffice\word.exe sample.doc

Note: 

The VisualInfo Client for Windows pre-appends the document file path with a
space. This makes it possible for an external application to parse the document
file path parameter in an unexpected manner.

For example, consider the following VIC.INI entry:

WWW_HTML_DOC=htm, c:\webviewer\webview.exe file:///

To open a file based on this entry, you might use the command

c:\webviewer\webview.exe file:/// c:\frnroot\work\docððð1.htm

which would launch a Web browser with the following URL:

file:/// c:\frnroot\work\docððð1.htm

The Client for Windows pre-appends a space in front of the filepath even
though the browser application is not expecting a space there.
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 Chapter 9. Printing documents

With the Client for Windows, you can print any document from a Table of Contents or
you can print one that is open in a document window. You can also print an entire
Table of Contents or all the documents contained in a folder. You select options for
printing on the Print Item window.

Figure 33. Print Item Window

When you print a document, you can print any annotations, index information, or note
logs that are associated with it, and you can print selected pages.

When you print a folder, you can choose to print its contents in full, a listing of its Table
of Contents, or both. Sometimes folders are nested: a folder itself contains folders,
these folders can likewise contain folders, and so on. Each level is called a recursion.
You can set a default recursion level for printing in the Operator Preferences window.
(See “Options and preferences” on page 15.) The recursion level indicates how deeply
the Client for Windows will “dig” into a nested folder structure to find documents to print.

To print a document or folder:

1. Do one of the following:

� Select a document in a TOC window

� Open a document

2. Then do one of the following:

� Select Print  from the File menu

� Click on the Tool Bar button that shows the printer

The Print Item window opens.

3. If you are printing a document, select one or more of the following options:
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 � Image Pages

 � Index Information

 � Note Log

Select Current Page , All Pages , or enter a range of pages.

If you want to print annotations with your document, select Markup .

4. If you are printing a folder, select one or both of the following options:

� Table of Contents

� Print Contents of Folder

To change your printer setup:

Use the two Page Setup windows to select a printer and set paper size, orientation,
and other print properties. You can use any printer on your network.

1. From the Print Item window, click the Settings  button. This opens the first Page
Setup window.

2. Select your paper source, size, and orientation.

3. Click the Printer  button. This opens the second Page Setup window.

4. Set the printer you want to use.

5. Click the Properties  button. This opens the Properties window.

6. Select the properties you want for your printer. Options vary with the printer
selected.
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Glossary of Terms and Abbreviations

This glossary defines terms and abbreviations specific to
the VisualInfo system. Terms used in the definitions that
are shown in italics are defined elsewhere in this
glossary.

A
access control .  The ability to limit access to certain
functions provided by the VisualInfo system and certain
objects stored in the system. For example, you can give
a user read-only access to an object through an access
list.

access list .  A list consisting of one or more individual
user IDs or user groups and the privilege set associated
with each user ID or user group. You use access lists to
control user access to objects in the VisualInfo system.
The objects that can be associated with access lists are
the data objects stored by users, index classes and
subsets, workbaskets, and workflows.

ADSM.  AdStar storage management

ADSM management class .  A logical area of storage
that is managed by ADSM.

API.  Application programming interface.

archive .  Persistent storage used for long-term
information retention, typically very inexpensive per unit
stored, but requiring a long response time. Often in a
different geographic location to protect against
equipment failures and natural disasters.

attribute .  The term used in the VisualInfo APIs for key
field.

B
base attributes .  A set of item indexes that is assigned
to each object. All VisualInfo objects have base
attributes, also known as key values.

binary large object (BLOB) .  A large stream of binary
data treated as a single object.

C
cache .  An area of storage used to temporarily store
objects on the client machine. See also object server
cache and LAN cache.

category .  Another term for index class. In the Dynamic
Page Builder sample application, it is the name of a list
box that contains index classes for collections of
magazine articles.

CIF.   Common interchange file.

CIU.   Common interchange unit.

client application .  An application written with the
VisualInfo APIs to customize a user interface.

collection .  A group of objects with a similar set of
management rules and contained within a storage group.
Every object is stored in a collection, and all objects in a
collection are stored in the same storage group.

common interchange file (CIF) .  A file that contains
one ImagePlus Interchange Architecture (IPIA) data
stream.

common interchange unit (CIU) .  The independent
unit of transfer for a common interchange file (CIF). It is
the part of the CIF that identifies the relationship to the
receiving database. A CIF may contain multiple CIUs.

configuration server .  An OS/2 component of
VisualInfo that acts as an interface between OS/2 clients
and the other components of VisualInfo. Each
configuration server stores profile information about each
client that links to it.

container .  In the folder manager, an object that can
contain other folders or documents.

content class .  The term used in the VisualInfo APIs for
data format.

custom system .  A tailored configuration of a VisualInfo
system that includes two or more nodes installed on a
local area network (LAN).
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D
data format .  A logical name assigned to a file type.
VisualInfo provides a large range of predefined data
formats. You can also define your own data format. For
example, you can define your own data format called
MYGIF and use it for GIF files. Referred to as content
class in the VisualInfo APIs.

DCA.   Document content architecture.

destager .  A function of the object server that moves
objects from the staging area to the first step in the
object's migration policy or management class.

document .  An object that can be stored, retrieved, and
exchanged among VisualInfo systems and users as a
separate unit. Also referred to as an object. A single
document can contain many different types of base
parts, including text, images, and objects such as
spreadsheet files.

document content architecture (DCA) .  An
architecture that guarantees information integrity for a
document being interchanged in an office system
network. DCA provides the rule for specifying form and
meaning of a document. It defines revisable form text
(changeable) and final form text (unchangeable).

E
element .  An object that the list manager allocates for
an application.

F
FFST.   First Failure Support Technology.

filesystem .  In AIX, the method of partitioning a hard
drive for storage.

First Failure Support Technology (FFST) .  An IBM
licensed program that improves availability for IBM
software applications by providing immediate event
notification and first failure data capture for software
events, and by automating event tracking and
management.

folder .  In VisualInfo, an object that can contain other
folders or documents. A folder can contain items with

specified key field values or items that are the results of
a search. Folders are represented by their table of
contents.

folder manager .  The VisualInfo data model for
managing digital objects as online documents and
folders. You can use the folder manager APIs as the
primary interface between your applications and the
VisualInfo data store.

H
handle .  A character string that represents an object,
and is used to retrieve the object.

history log .  A file that keeps a record of activities for a
workflow.

I
Image Object Content Architecture (IOCA) .  A
collection of constructs used to interchange and present
images.

index class .  A category for storing and retrieving
objects, consisting of a named set of attributes known as
key fields. When you create a document or folder in the
VisualInfo system, your application must assign an index
class and supply the key field values required by that
class. An index class identifies the automatic processing
requirements and storage requirements for an object.

index class subset .  A view of an index class that an
application uses to store, retrieve, and display folders
and objects. An index class subset usually contains a
subset of the index class's key fields.

index class view .  The term used in the APIs for index
class subset.

inline .  In VisualInfo, an object that is online and in a
drive, but has no active mounts. Contrast with mounted.

interchange .  The capability to import or export an
image along with its index from one ImagePlus system
to another ImagePlus system using CIF or CIU.

item .  The smallest unit of information that the library
server administers. An item can be a folder, document,
workbasket, or workflow.
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K
key field .  An attribute of a document or folder that
represents a type of information about that item. For
example, a customer data document might have key
fields for the customer's name and social security
number.

L
LAN cache .  An area of temporary storage on a local
object server that contains a copy of objects stored on a
remote object server.

library client .  The component of a VisualInfo system
that provides a low-level programming interface for the
library system. The library client includes APIs that are
part of the Application Development Toolkit.

library object .  A folder, document, or workbasket.
Library objects are stored on the library server.

library server .  The component of a VisualInfo system
that contains index information for the objects stored on
one or more object servers.

list manager .  An OS/2 component in a VisualInfo
system that can control workstation cache. The list
manager server manages electronic queues (called lists)
for the clients that link to it. The configuration server is a
type of list manager server.

M
machine-generated data structure (MGDS) .  (1) An
IBM structured data format protocol for passing
character data among the various ImagePlus programs.
(2) Data extracted from an image and put into
generalized data stream (GDS) format.

management class .  A user-defined schedule for
moving objects from one storage class to the next. It
describes the retention and class transition
characteristics for a group of objects in a storage
hierarchy. Also known as migration policy.

MGDS.  Machine-generated data structure.

migration .  (1) The process of moving data and source
from one computer system to another computer system
without converting the data, such as when moving to a

new operating environment. (2) Installation of a new
version or release of a program to replace an earlier
version or release.

migration policy .  Synonym for management class.

migrator .  A function of the object server that checks
management classes and moves objects to the next
storage class when they are scheduled to move.

Mixed Object Document Content Architecture
(MO:DCA) .  An IBM architecture developed to allow the
interchange of object data among applications within the
interchange environment and among environments.

Mixed Object Document Content
Architecture—Presentation (MO:DCA—P) .  A subset
architecture of MO:DCA that is used as an envelope to
contain documents that are sent to the ImagePlus
workstation for displaying or printing.

MO:DCA .   Mixed Object Document Content
Architecture.

MO:DCA—P .   Mixed Object Document Content
Architecture—Presentation.

mount .  To place a data medium in a position to
operate.

mounted .  In VisualInfo, an object that is online and in
a drive, with active mounts. Contrast with inline.

N
network table file .  A text file created during installation
that contains the system-specific configuration
information for each node in a VisualInfo system. Each
node must have a network table file that identifies it and
lists the nodes that it connects to. The name of the
network table is always FRNOLNT.TBL.

O
object .  Any binary data entity stored on an object
server. In the folder manager data model, object
specifically refers to a document's contents or base
parts. See also binary large object (BLOB).

object server .  The component of a VisualInfo system
that physically stores the objects or information stored
and accessed by the client applications.
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object server cache .  The working storage area for the
object server. Also called the staging area.

OLE.  Object Linking and Embedding. A Microsoft
specification for linking and embedding applications so
that they can be activated from within other applications.

overlay .  A collection of predefined data such as lines,
shading, text, boxes, or logos, that can be merged with
variable data on a page while printing.

P
patron .  The term used in the VisualInfo APIs for user.

privilege .  An authorization for a user to either access
or perform certain tasks on objects stored in the
VisualInfo system. Privileges are assigned by the system
administrator.

privilege set .  A collection of privileges for working with
system components and functions. The system
administrator assigns privilege sets to users (user IDs)
and user groups.

property .  A characteristic of an object that can be
changed or modified. The properties of an object
describe the object. Type style is an example of a
property.

purger .  A function of the object server that removes
objects from the system.

R
render .  To take data that is not typically image-oriented
and depict or display it as an image. In VisualInfo,
word-processing documents can be rendered as images
for display purposes.

S
search criteria .  In VisualInfo, values typed into key
fields that are used to retrieve a stored item.

SMS.   System-managed storage.

SMS server .  A VisualInfo object server component
used to support the administration of the object server.
See also object server, system-managed storage.

Software developers toolkit .  A set of application
programming interfaces that you can use to build custom
VisualInfo applications. The toolkit includes APIs for the
folder manager and the library client.

staging .  The process of moving a stored object from
an offline or low-priority device back to an online or
higher priority device, usually on demand of the system
or on request of a user. When a user requests an object
stored in permanent storage, a working copy is written to
the staging area.

staging area .  The working storage area for the object
server. Also referred to as object server cache.

stand-alone system .  A preconfigured VisualInfo
system with all of the system components installed on a
single personal computer.

storage class .  A named list of storage attributes. The
list of attributes identifies a storage service level
provided for data associated with the storage class. No
physical storage is directly associated with a given
storage class name. However, device drivers are
associated with the storage class, and storage groups
are used with a storage class to define the physical
storage.

storage class identifier .  The identifier associated with
a storage class. This identifier is assigned by the
VisualInfo system, not by the user.

storage group .  A named collection of physical devices
managed as a single storage area for objects. You use a
storage group to define a category in which to store
groups of objects. A storage group is used to limit a
storage class.

Storage groups are defined during initial installation of a
VisualInfo system, during customization, or dynamically
by a run-time function.

storage group identifier .  The identifier associated with
a storage group. This identifier is assigned by the
VisualInfo system, not by the user.

storage system .  A generic term for storage in the
VisualInfo system. See ADSM management class,
volume

suspend .  In VisualInfo, to remove an object from its
workflow and define the suspension criteria needed to
activate it. Activating the object later enables it to
continue processing.
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system-managed storage (SMS) .  The VisualInfo
approach to storage management. The system
determines object placement, and automatically
manages object backup, movement, space, and security.

T
table of contents (TOC) .  In VisualInfo, the list of
objects contained in a folder or workbasket. Search
results are displayed as a folder table of contents.

thumbnail .  A small representation of a document page.
In the VisualInfo Client for Windows, an optional
thumbnail bar displays the pages of the active
document.

TOC.  Table of contents

U
user .  A person who requires the services of VisualInfo.
This term generally refers to users of client applications,
rather than the developers of applications, who use the
VisualInfo APIs. See also patron.

user group .  A group consisting of one or more

individual user IDs defined under a single group name. A
user group can be assigned a single privilege set.

utility server .  A VisualInfo component used by the
database utilities for scheduling purposes. You configure
a utility server when you configure an object server or
library server. There is one utility server for each object
server and each library server. Also known as database
interface server or reorg server.

V
volume .  A representation of an actual physical storage
device or unit that the objects in your system are stored
on.

W
workbasket .  A logical location in the VisualInfo system
to which objects can be assigned to wait for further
processing. A workbasket definition includes the rules
that govern the presentation, status, and security of its
contents.

workflow .  A sequence of workbaskets that a document
or folder travels through while it is being processed.
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A
About This Book ix
activating an item 66
advanced search

description 44
groups 46
parameters 51, 52
performing 44
search expression syntax 48
search forms 45
Search Query Builder 47
templates 50

Advanced Search Forms List 45
Advanced Search Forms window 46, 47
annotating

arrow 75
box 74
bringing to front 79
changing location 78
changing size 78
circle 75
color 80
deleting 79
documents 72
folders 60
highlighter 74
line 75
notes 77
pen 73
property sheet 80
selecting 78
sending to back 79
showing and hiding 77
stamp 76
text 76
transparent 80

arrow tool 75
attributes, search expressions 49

B
Basic Scan window 22
basic search 43
Basic Search window 43, 60
box tool 74

brackets, search expressions 50
bringing to the front 79
Browse mode 69
buttons

bring to front 79
eraser 79
Main Window toolbar 13
selection 78
send to back 79
show/hide 77

C
case sensitivity 54
changing workflows 62
checked-out symbols 37
checking items out and in 36
circle tool 75
Client for Windows

concepts 1
implementation example 5
logging off 19
logging on 8
Main Window 9
Product Information window 18
starting 7

client messenger 7
closing items 38
colors for annotations 80
Comment Bar 68
comments

See highlights
completing a workflow 63
concepts, Client for Windows 1
Configure Key Field Layout window 33
contextual help 17
conventions used in book x
count of items in workbasket 58

D
data formats for scanning 24
dates, 2- and 4- digit 17
default index class 40
deleting items 38
deselecting items 36
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displaying a count of items 58
Document Bar 68
Document window 22
documents

activating 66
adding to folder 60
annotating 72
checking out and in 36
closing 38
displayed 67
exporting 26
importing 25
indexing 41
locating 43
moving through workflows 62
non-image 81
opening 37
pages

enhancing images 70
fitting 71
inverting images 70
moving between 69
rotating 70

printing 83
priority in a workbasket 58
processing in workflow 61
removing and deleting

from a workbasket 38
removing from workflow 63
routing to workbasket 4
scanning 21
selecting 36
suspending 64
viewing 69
zooming 71

E
Edit Index window 41
enhancing images 70
entering documents

importing 25
scanning 21

eraser tool 79
example of implementation 5
exporting 26

F
fileroom

overview 1
searching 43

fitting pages 71
folders

activating 66
adding items 60
annotating 60
checking out and in 36
closing 38
creating 59
indexing 41
locating 43
menus 55
moving through workflows 62
opening 37, 59
overview 59
print recursions 83
printing 83
priority in a workbasket 58
removing and deleting 38
removing from workflow 63
routing to workbasket 4
search results 31
selecting 36
selection icon 30
suspending a folder

until a date and time 65
until items are received 65

table of contents (TOC) 30

G
General help 18
groups for advanced searches 46

H
hash marks 36
Help

general 18
getting 17
Help Index 18
hypertext links in 19
using 18

Help window 18
highlighter tool 74
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highlighting in table of contents 36
highlights

with non-image documents 81
HP scanners 23
hypertext links 19

I
IBM 2456 scanners 24
icons

checked-out items 37
folder selection 30

images
enhancing 70
inverting 70

implementation example 5
Import Object window 25
importing 25
index classes

all index class search 44
default 40
NOINDEX 39, 44
overview 39

indexing
documents 41
Edit Index window 41
folders 41
overview 3, 38

insurance company example 5
inverting images 70

K
key fields

default values 41
in index classes 39
layout, configuring 32

L
legal notices vii
line tool 75
locating documents and folders

See searching
logging off 19
logging on 8
logical operators, search expressions 50
Logon dialox box

M
Main window

menus 9
overview 8
status bar 14
tool bar 13

markup
See annotating

Maximum TOC count 35
menus

Main Window 9
Options 15
Process 55
Selected 55
Window 16
Workbasket 55
Workflow 61

messenger, client 7
moving between document pages 69

N
NOINDEX

index class 39
search 44

non-image documents
annotations 81
viewing 81

Notes window 61
notices vii
number of items in workbasket 58

O
opening items 37
Operator Preferences window 40
options

default index class 40
display number of items 58
layout 32
Main Window 15
thumbnails 69

Options menu 15

P
pages

enhancing images 70
fitting 71
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pages (continued)
inverting images 70
moving between 69
rotating 70
zooming 71

Parameters for Search Form window 52
parameters, search expressions 51
pen tool 73
preface ix
preferences

default index class 40
display workbasket item count 58
Main Window 15
Maximum TOC count 35
print recursions 83
printing 83
property sheets 80
thumbnails 69

Print Item window 83
Printer Setup window 84
printing documents and folders 83
priority of items in workbasket 58
priority, changing document and folder 4
Process menu 55
Product Information window 18
property sheet 80

R
recursions 83
relation symbols, search expressions 49
removing items 38
removing items from workflow 63
resolution for scanning 21
reverse video 70
reversing images 70
rotating pages 70
routing documents and folders 4
row size, changing 34

S
Scanner Selection window 23
Scanner Settings window 23
scanner setup 23
scanning

Basic Scan window 22
data formats 24
overview 2
procedure 21

scanning (continued)
recommended resolution 21
scanner considerations 23
scanner setup 23

scanning documents 21
search expressions

creating 47
syntax 48

search forms
creating or editing 45
parameters 51
Parameters for Search Form window 52
performing an advanced search 44
search expression syntax 48
Search Query Builder 47
templates 50

Search Options window 53
Search Query Builder 47
searching

advanced search 44
advanced search parameters 51, 52
all index class search 44
basic search 43
case sensitivity 54
NOINDEX search 44
overview 3
search expression syntax 48
search form templates 50
search forms 45
search options 53
Search Query Builder 47
search results folder 31
wild card searches 54

Select Workbasket window 57
Selected menu 55
selecting a folder or document 36
selection button 78
selection emphasis 36
selection icon 30
sending to the back 79
show/hide button 77
sort order arrow 34
stamp tool 76
starting the Client for Windows 7
status bar, Main Window 14
sticky notes

annotation tool 77
with non-image documents 81

Suspend Folder window 65
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Suspend window 64
suspending a document 64
suspending a folder

until a date and time 65
until items are received 65

system-assigned workbasket 56

T
Table of Contents window 29
tables of contents

checking items out and in 36
closing items 38
controlling TOC appearance

column heading row size 34
column size 34
configuring the key field layout 32
row size 34
sort order 33
sorting 33

deselecting items 36
folder 30
hash marks 36
highlighting 36
index class tabs 29
number of items 35
opening 31
opening items 37
overview 29
refreshing 35
removing and deleting items 38
search results 31
selecting items 35, 36
selection emphasis 36
types 30
workbasket 31

text tool 76
thumbnail bar

moving between pages 69
Options 15

thumbnails 69
TOC

See tables of contents
toolbar

for documents 68
main window 13
Options 15

trademarks vii
Transparent option

annotations 80

U
user-selected workbaskets 56

V
values, search expressions 49
Viewer window

overview 67
viewing documents

Browse mode 69
document window 67
enhancing images 70
fitting pages 71
inverting images 70
moving between pages 69
non-image documents 81
overview 67, 69
rotating a page 70
thumbnails 69
zooming 71

VisualInfo
client messenger 7
documentation x
overview 1
role of the Client Application 1

W
wild card searches 54
window display 16
Window menu 16
windows

Advanced Search Forms 46, 47
Advanced Search Forms List 45
Basic Scan 22
Basic Search 43, 60
Configure Key Field Layout 33
Document 67
Edit Index 41
Help 18
Import Object 25
Logon 7
Main 9
Notes 61
Operator Preferences 40
Parameters for Search Form 52
Print Item 83
Printer Setup 84
Product Information 18
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windows (continued)
Scanner Selection 23
Scanner Settings 23
Search Options 53
Select Workbasket 57
Suspend 64
Suspend Folder 65
Table of Contents 29
Zoom dialog box 72

Workbasket menu 55
workbaskets

adding items 57
displaying a count of items 58
menus 55
opening 57
overview 55, 56
priority of items 58
routing documents and folders 4
system-assigned 56
table of contents 31
user-selected 56

workflow
changing 62
completing 63
menu 61
menus 55
overview 61
removing items 63
starting 62
suspending items 63

X
XIONICS scanners 23

Y
Year 2000 enablement 17

Z
Zoom dialog box 72
zooming 71
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